Topcon Link
Data Import/Export Software

Reference Manual
Table of Contents

Preface ................................................................. vii
   Terms and Conditions .................................................... vii
   Manual Conventions ..................................................... x

What’s New with Topcon Link ...................... xiii

Chapter 1
Introduction ......................................................... 1-1
   System Requirements for Topcon Link ..................... 1-3
   Installing Topcon Link ........................................... 1-3
   Starting Topcon Link .............................................. 1-5
   Getting Acquainted .............................................. 1-6
      Main Window ...................................................... 1-6
      Menu Bar .......................................................... 1-7
         File Menu ...................................................... 1-7
         Edit Menu .................................................... 1-7
         View Menu .................................................... 1-8
         Process Menu ............................................... 1-8
         Window Menu ............................................... 1-9
         Help Menu .................................................... 1-9
      Toolbar ............................................................ 1-10
      Status Bar ........................................................ 1-12

Chapter 2
Transferring Files ........................................... 2-1
   Importing Files .................................................... 2-1
      Importing From a Receiver ................................. 2-2
         Using Windows Explorer .............................. 2-2
         Using Topcon Link ...................................... 2-4
      Importing TPS Controller Files ......................... 2-6
         Microsoft ActiveSync Settings ..................... 2-8
         Using Windows Explorer .............................. 2-10
# Table of Contents

Using Topcon Link ................................................ 2-11
Importing From Total Station ....................................... 2-12
Using Windows Explorer ........................................... 2-12
Using Topcon Link ................................................ 2-14
Importing From Digital Level ...................................... 2-17
Using Windows Explorer ........................................... 2-17
Using Topcon Link ................................................ 2-19
Import from a Memory Card ........................................... 2-22
Using Windows Explorer ........................................... 2-22
Using Topcon Link ................................................ 2-23
Exporting Files To Device ........................................... 2-25
Exporting to a TPS Controller ...................................... 2-26
Using Windows Explorer ........................................... 2-26
Using Topcon Link ................................................ 2-27
Exporting to a Total Station ........................................... 2-28
Using Windows Explorer ........................................... 2-28
Using Topcon Link ................................................ 2-30
Exporting an OAF to TPS Receivers ................................... 2-32

## Chapter 3

### Converting Files ............................................... 3-1

Creating a Custom Projection ...................................... 3-7
Creating a Custom Datum ........................................... 3-8
Converting Coordinate Files ......................................... 3-10
    TopSURV Coordinates and Custom
    Text Format Parameters ........................................ 3-12
    Name,Lat,Lon,H,Code Format Parameters ................... 3-13
    Other Coordinate File Types Format Parameters ........... 3-13
Converting a TopSURV PC Job ...................................... 3-15
Converting Total Station Raw Data Files ......................... 3-18
    Converting to Custom TSRaw Format ......................... 3-22
Converting Topcon XML Files ................................... 3-23
Converting Design Files ........................................... 3-24
Converting Localization Files ................................... 3-25
Converting GPS+ Raw Data Files ................................ 3-26
Converting to SHP Files ........................................... 3-26
Converting to TPD GPS+ Raw Data Files ......................... 3-29
## Table of Contents

Converting to RINEX/Compact RINEX GPS+
- Raw Data Files ................................................................. 3-30
- Converting Geoid Files ................................................... 3-31
- Converting to Topcon Geoid Files .................................. 3-31
- Converting Code Library Files ........................................ 3-32
- Converting to GPS Observation Files ........................... 3-33
- Converting to Custom Vector Files ............................... 3-33
- Converting Cut Sheet Files ............................................... 3-34
- Creating Cut Sheet Standard Files ................................. 3-34
- Creating a Cut Sheet User Defined File ........................ 3-37
- Converting Road and X-Section Templates File ................. 3-39

### Chapter 4

#### Maintaining Files ................................................. 4-1

- Opening Files ....................................................................... 4-1
  - Creating User-defined File Formats .......................... 4-2
  - Opening a File Using Drag-and-drop ....................... 4-6
- Viewing Files ....................................................................... 4-7
  - Coordinate File Data Tables ........................................ 4-8
  - Displaying Total Station Raw Data File Data Table .... 4-11
    - About Vertical Angles ............................................. 4-16
    - Displaying Digital Level Observation .................... 4-18
  - TopSURV File Data Table ............................................ 4-21
  - CAD View ..................................................................... 4-37
    - Displaying CAD View Options ................................. 4-38
  - Viewing File Properties .............................................. 4-39
- Editing Files ........................................................................ 4-41
  - Saving Files ................................................................... 4-41
  - Converting Opened Files to Other File Formats ........... 4-41
  - Editing Coordinate Files ............................................... 4-42
    - Edit Name and Note Properties .............................. 4-44
    - Edit Coordinate Properties ..................................... 4-45
    - Edit CAD Properties ................................................ 4-46
    - Edit Offset Properties ............................................ 4-46
  - Saving Note and Code Changes in Coordinate Files to a Different Coordinate File .......................... 4-47
  - Editing Total Station Raw Data Files ............................ 4-48
## Table of Contents

Editing Name, Instrument Height, and Number Properties .............................................. 4-50
Editing Point To, Notes and Codes Properties ...... 4-51
Editing Reflector Height and Azimuth Properties . 4-51
Editing Offset Properties ................................. 4-52
Editing String Properties ................................. 4-53
Editing TS Observation Display Properties ........ 4-54
Editing Point Code Description ......................... 4-55
Editing the Type of Point ............................... 4-55
Editing Multiple Points ................................. 4-56
Editing TopSURV Files ........................................... 4-56
Editing Point Name and Note Properties ............. 4-58
Editing Point Coordinates ............................... 4-58
Adding a New Point Code ................................... 4-59
Editing Offset Properties ............................... 4-60
Editing GPS Occupation Point Name .................. 4-61
Editing GPS Occupation Antenna Parameters ....... 4-61
Adding Antennas Using the Custom Antenna List 4-62
Edit GPS Occupation Offsets ........................... 4-64
Editing GPS Occupations Display Properties ...... 4-65
Editing TS Obs Parameters .............................. 4-65
Editing GPS Obs Point Notes ............................ 4-65
Editing GPS Observation Display Properties ...... 4-66
Editing TopSURV File Codes ............................ 4-67

## Chapter 5
### Using Files ............................................................... 5-1

Changing Localization Data ........................................... 5-1
Localization Basics ..................................................... 5-1
Horizontal and Vertical Localization Determinations .. 5-2
Accuracy Estimation for Localization Parameters ...... 5-4
Editing Localization Parameters ............................ 5-5
Computing Coordinates .............................................. 5-9
Traverse Adjustment .................................................... 5-10
Setting the Adjustment Type ............................... 5-11
Setting the Refraction Coefficient ......................... 5-12
Least Squares Method .............................................. 5-13
Compass Rule ........................................................... 5-13
Transit Rule ................................................................. 5-14
Crandall Method .......................................................... 5-14
Interior Angle Balancing Method ............................... 5-15
Azimuth Balancing Method ........................................... 5-15
User-defined Parameters ............................................. 5-15
Layers View Options ..................................................... 5-19
Tabular View Options .................................................... 5-20
Printing Files ................................................................. 5-21

Appendix A
Receiver Options and Offset Types ......................... A-1
  Option Authorization File ........................................... A-1
  Offset Types in Topcon Link ..................................... A-2
    Offsets From an Observation Line ......................... A-2
    Offset Point to Line ........................................... A-3
    Offsets From a Line with Known Azimuth ............... A-5

Appendix B
Creating a Regional Geoid Model File ..................... B-1

Appendix C
Sample File Formats .................................................. C-1
  Coordinate File Formats .......................................... C-1
    GTS-6 Points Coordinate Format ......................... C-1
    GTS-7 Points Coordinate Format ......................... C-2
    Name,E,N,Z,Code Coordinate Format .................. C-3
    Name,Lat,Lon,Ht,Code Coordinate Format ............ C-3
    Name,N,E,Z,Code Coordinate Format .................. C-4
  Raw Data File Formats .......................................... C-5
    GTS-6 Raw Format ........................................... C-5
    GTS-7 Raw Format ........................................... C-6
    GTS-7+ Raw Format ........................................ C-9
  TOPCON XML File Format ..................................... C-9
  DXF Format ........................................................ C-11
  LandXML File Format ........................................... C-14
  Regional Geoid Model File .................................... C-15
  GPS Vector File Format ......................................... C-15
  Cut Sheet Files ..................................................... C-16
Table of Contents

Printed File Formats ............................................................ C-19

Appendix D

Cables/COM Ports ......................................................... D-1
  Serial Interface Cable .................................................. D-1
  Parallel Interface Cable ................................................. D-2
  Serial C-RS232C Connector Definition .............................. D-3
  Total Station COM Port Settings ..................................... D-4
  GNSS Receiver COM Port Settings .................................. D-7

Index
Preface

Thank you for purchasing your Topcon receiver, survey product or accessory (the “Product”). The materials available in this manual (the “Manual”) have been prepared by Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon products. This Manual is designed to assist owners with the use of software (the “Software”) to be used with the Product and its use is subject to these terms and conditions (the “Terms and Conditions”).

NOTICE

Please read these Terms and Conditions carefully.

Terms and Conditions

USE – This product is designed to be used by a professional. The user should have a good knowledge of the safe use of the product and implement the types of safety procedures recommended by the local government protection agency for both private use and commercial job sites.

COPYRIGHT – All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights are reserved. You may not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute, or allow any third party access to, any graphics, content, information or data in this Manual without the expressed written consent from TPS and may only use such information for the care and operation of your Product. The information and data in this Manual are a valuable asset of TPS and are developed by the expenditure of considerable work, time and money, and are the result of original selection, coordination and arrangement by TPS.
TRADEMARKS – Topcon®, Topcon Link™, TopSURV™, and Topcon Positioning Systems™ are trademarks of TPS. Windows® and ActiveSync® are registered trademarks of Microsoft Corporation. Product and company names mentioned herein may be trademarks of their respective owners.

DISCLAIMER OF WARRANTY – EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL, THE PRODUCT, AND ANY ACCOMPANYING SOFTWARE ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL, THE SOFTWARE, OR THE PRODUCT. SUCH DISCLAIMED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION, TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE PRODUCT.

LICENSE AGREEMENT – Use of the Software and any other computer programs or software supplied by TPS or downloaded from a TPS website (the “Software”) to be used with a Topcon Product constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide by these Terms and Conditions. The user is granted a personal, non-exclusive, non-transferable license to use
such Software under the terms stated herein and in any case only with a single Product or single computer. You may make one (1) backup copy of the Software. Otherwise, the Software may not be copied or reproduced. You may not assign or transfer the Software or this license without the express written consent of TPS. This license is effective until terminated. You may terminate the license at any time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of the Terms or Conditions. You agree to destroy the Software and manual upon termination of your use of the Product. All ownership, copyright and other intellectual property rights in and to the Software belong to TPS. If these license terms are not acceptable, return any unused Software and the Manual.

CONFIDENTIALITY – This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and proprietary information of TPS. You agree to treat TPS’ Confidential Information with a degree of care no less stringent than the degree of care you would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict you from disclosing Confidential Information to your employees as may be necessary or appropriate to operate or care for the Product. Such employees must also keep the Confidentiality Information confidential. In the event you become legally compelled to disclose any of the Confidential Information, you shall give TPS immediate notice so that it may seek a protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS – No statement contained at the TPS website (or any other website) or in any other advertisements or TPS literature or made by an employee or independent contractor of TPS modifies these Terms and Conditions (including the Software License Agreement, Disclaimer of Warranty and limitation of liability).

SAFETY – Improper use of a Topcon Product can lead to injury to persons or property and/or malfunction of the Product. The Product should only be repaired by authorized TPS warranty service centers.
Users should review and heed the safety warnings in the manual accompanying the Product.

MISCELLANEOUS – The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The above Terms and Conditions will be governed by, and construed in accordance with, the laws of the State of California, without reference to conflict of laws.

Manual Conventions

This manual uses the following conventions:

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>File ▶ Exit</td>
<td>Click the File menu and click Exit.</td>
</tr>
<tr>
<td>Enter</td>
<td>Indicates the button or key labeled Enter.</td>
</tr>
<tr>
<td>Topo</td>
<td>Indicates the name of a dialog box or screen.</td>
</tr>
<tr>
<td>Notes</td>
<td>Indicates a field on a dialog box or screen, or a tab within a dialog box or screen.</td>
</tr>
</tbody>
</table>

TIP

Supplementary information that can help you configure, maintain, or set up a system.

NOTICE

Supplementary information that can have an affect on system operation, system performance, measurements, personal safety.
CAUTION

Notification that an action has the potential to adversely affect system operation, system performance, data integrity, or personal health.
What’s New with Topcon Link

The following briefly describes some of the new features and functions for Topcon Link.

- Files (data) can be imported from a Topcon Memory Card.
- GPS+ raw and DL observation files can be downloaded for viewing.
- The file formats for Design (*.tn3, *.dwg, *.dxt) and SHP (*.shp) files have been added for data conversion.
Introduction

Topcon Link™ can be used to:

- Import files from Topcon Digital Level, Total Stations, Topcon Memory Cards, TPS controllers, and GPS+ receivers to a PC.
- View and edit coordinate, raw data, and TopSURV files.
- Open and view GPS+ Raw Data and Digital Level Observation files.
- Export an Option Authorization File (OAF) from a computer to TPS GPS+ receivers, coordinate data files to a Total Station, or any file to a TPS Controller.
- Edit localization parameters.
- View Linework information and images in a TopSURV job.
- Convert coordinate, raw data, GPS+ Raw Data, and TopSURV files to files of the following formats.

**Table 1-1. Topcon Link File Formats**

<table>
<thead>
<tr>
<th>Coordinate files</th>
<th>GPS+ Raw Data Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>TopSURV Coordinates (*.txt)</td>
<td>Compact RINEX files (*.??D; *.??G; *.??N)</td>
</tr>
<tr>
<td>CR-5 Files (*.CR5)</td>
<td>RINEX files (*.??O; *.??G; *.??N)</td>
</tr>
<tr>
<td>Custom Text Format files (<em>.</em>)</td>
<td>TPD files (*.tpd)</td>
</tr>
<tr>
<td>FC-4 Points (*.xyz; *.fc4; *.pnt)</td>
<td>Road Files</td>
</tr>
<tr>
<td>FC-5 Points (*.xyz; *.fc5; *.pnt)</td>
<td>CLIP Road Files (*.PLT)</td>
</tr>
<tr>
<td>GTS-210/310-10 Points (*.xyz; *.pnt)</td>
<td>ISPOL Road Files (*.ALI)</td>
</tr>
<tr>
<td>GTS-210/310-12 Points (*.xyz; *.pnt)</td>
<td>TDS RD5 (*.RD5)</td>
</tr>
<tr>
<td>GTS-7 Points (*.xyz; *.pnt)</td>
<td>Topcon MC Road files (*.RD3)</td>
</tr>
<tr>
<td>Name,E,N,Z,Code (*.csv)</td>
<td>Topcon SSS Road files (*.HAL)</td>
</tr>
<tr>
<td>Name,Lat,Lon,Hz,Code (*.csv)</td>
<td>TopSURV Road files (*.THL)</td>
</tr>
<tr>
<td>Name,N,E,Z,Code (*.csv)</td>
<td>Topcon XML Road files (*.xml)</td>
</tr>
<tr>
<td>Topcon XML Points (*.xml)</td>
<td>LandXML Road files (*.xml)</td>
</tr>
<tr>
<td>LandXML Points (*.xml)</td>
<td>VGP files (*.vgp)</td>
</tr>
</tbody>
</table>
### Table 1-1. Topcon Link File Formats (Continued)

<table>
<thead>
<tr>
<th>Topcon Geoid files (*.gff)</th>
<th>TopSURV Database Files (*.tlsv)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut Sheet files</td>
<td></td>
</tr>
<tr>
<td>Cut Sheet Standard files (*.css)</td>
<td></td>
</tr>
<tr>
<td>Cut Sheet User Defined files (*.csu)</td>
<td></td>
</tr>
<tr>
<td>Code Library Files</td>
<td></td>
</tr>
<tr>
<td>DBF Code Library files (*.dbf)</td>
<td></td>
</tr>
<tr>
<td>TDD Code Library files (*.tdd)</td>
<td></td>
</tr>
<tr>
<td>XML Code Library files (*.xml)</td>
<td></td>
</tr>
<tr>
<td>Code Library Files</td>
<td></td>
</tr>
<tr>
<td>Shape Files</td>
<td></td>
</tr>
<tr>
<td>Design Files</td>
<td></td>
</tr>
<tr>
<td>DWG files (*.dwg)</td>
<td></td>
</tr>
<tr>
<td>DXF files (*.dxf)</td>
<td></td>
</tr>
<tr>
<td>Land XML files (*.xml)</td>
<td></td>
</tr>
<tr>
<td>TN3 Surface (*.TN3)</td>
<td></td>
</tr>
<tr>
<td>GPS Obs Files</td>
<td></td>
</tr>
<tr>
<td>Custom Text Format (<em>.</em>)</td>
<td></td>
</tr>
<tr>
<td>Land XML GPS Obs (*.xml)</td>
<td></td>
</tr>
<tr>
<td>Topcon Vector (*.tvf)</td>
<td></td>
</tr>
<tr>
<td>Topcon XML GPS Obs (*.xml)</td>
<td></td>
</tr>
<tr>
<td>Topcon XML Files (*.xml)</td>
<td></td>
</tr>
<tr>
<td>Localization Files (*.gc3)</td>
<td></td>
</tr>
<tr>
<td>TS Raw Data Files</td>
<td></td>
</tr>
<tr>
<td>Custom TSRaw Format (<em>.</em>)</td>
<td></td>
</tr>
<tr>
<td>FC-5 Raw (*.raw; *.dat; *.fc5)</td>
<td></td>
</tr>
<tr>
<td>GTS-210/310 Raw (*.raw; *.dat; *.gts; *.gt6)</td>
<td></td>
</tr>
<tr>
<td>GTS-6 No Station Raw (*.raw; *.dat; *.gts; *.gt6)</td>
<td></td>
</tr>
<tr>
<td>GTS-6 Raw (*.raw; *.dat; *.gts; *.gt6)</td>
<td></td>
</tr>
<tr>
<td>GTS-7 Raw (*.raw; *.dat; *.gts; *.gt7)</td>
<td></td>
</tr>
<tr>
<td>GTS-7+ Raw (*.raw; *.dat; *.gts; *.gt7)</td>
<td></td>
</tr>
<tr>
<td>Resect Sheet (*.sht)</td>
<td></td>
</tr>
<tr>
<td>Land XML files (*.xml)</td>
<td></td>
</tr>
<tr>
<td>Topcon XML files (*.xml)</td>
<td></td>
</tr>
<tr>
<td>X-Section Templates</td>
<td></td>
</tr>
<tr>
<td>TDS PT5 X-Section (*.tp5)</td>
<td></td>
</tr>
<tr>
<td>Topcon SSS X-Section (*.xtf)</td>
<td></td>
</tr>
<tr>
<td>Topcon XML X-Section Template (*.xml)</td>
<td></td>
</tr>
<tr>
<td>TopSURV X-Section (*.xst)</td>
<td></td>
</tr>
</tbody>
</table>
System Requirements for Topcon Link

Before installing Topcon Link, ensure the computer or laptop has the following requirements.

- Processor compatible with Intel® Pentium® 100 MHz or faster
- 5 MB free disk space
- 16 MB RAM or more (32 MB recommended)
- 32-bit operating system, such as MS Windows 98/2000/XP
- Color monitor with 640x480 screen resolution

Installing Topcon Link

Topcon Link can be installed onto a computer from the CD included with the package, or from the Topcon website.

1. To install Topcon Link, do one of the following:
   - Insert the Topcon Link CD into the CD-ROM drive of the computer. The InstallShield® Wizard starts up.
   - Go to the TPS Survey website and click Software. Then click Utilities (http://www.topconsurvey.com/software/index.html#util) and click the Topcon Link 6.04 link. Download the file and extract the Topcon Link installer. Double-click the TLinkSetup.6.04.exe file to start the InstallShield Wizard.

2. Click Next to start the installation process.

3. Click Yes on the License Agreement dialog box (Figure 1-1 on page 1-4). Clicking No terminates the installation.

4. On the Customer Information dialog box, enter the User and Company names, then click Next (Figure 1-1 on page 1-4).
5. On the Choose Destination Location dialog box, click **Browse** to select the folder or enter a new folder name in which to install Topcon Link. Click **Next** (Figure 1-2 on page 1-4).

6. On the Select Program Folder dialog box, select a current folder or type a new program folder name for Topcon Link (Figure 1-2). Then click **Next** to start the installation process.
7. Click **Finish** to exit the installation (Figure 1-3).

![Figure 1-3. Installation Complete](image)

8. Create a Topcon Link shortcut (Figure 1-4) on the computer desktop to quickly start the program.

![Figure 1-4. Topcon Link Shortcut](image)

## Starting Topcon Link

To start Topcon Link, do one of the following:

- Click **Start ➤ Programs ➤ Topcon ➤ Topcon Link.**
- Double-click the Topcon Link desktop shortcut.

The Topcon Link main window displays (see “Main Window” below).
Getting Acquainted

This section introduces the various functions available in Topcon Link for viewing, configuring, or editing data files.

Main Window

The main window (Figure 1-5) has the following components:

- Title bar – contains the name of the program.
- System buttons – minimizes, maximizes, and closes windows.
- Menu bar – contains drop-down menus for the various Topcon Link functions.
- Toolbar – contains shortcut buttons to frequently used options.
- Work area – displays dialog boxes, job file information, and pop-up menus.
- Status bar – displays informative messages about Topcon Tools and various files.
- File information – displays the linear unit, angular unit, type of coordinate system, and coordinate system information used in the open job.

Figure 1-5. Main Window Components
Menu Bar

The menu bar provides access to most Topcon Link options available using six drop-down menus.

File Menu

The File menu (Figure 1-6):

- opens, saves, and closes a file
- imports and exports data
- converts a file from one format to another
- prints information from an active file
- displays job file configuration parameters
- displays recently accessed files

<table>
<thead>
<tr>
<th>File</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Open File...</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save File</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save As...</td>
<td>Alt+Ctrl+S</td>
</tr>
<tr>
<td>Import from Device...</td>
<td>Shift+F2</td>
</tr>
<tr>
<td>Export to Device...</td>
<td>Shift+F4</td>
</tr>
<tr>
<td>Connect File...</td>
<td>F5</td>
</tr>
<tr>
<td>Print...</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Print Preview</td>
<td></td>
</tr>
<tr>
<td>Page Setup...</td>
<td></td>
</tr>
<tr>
<td>Configuration...</td>
<td>Ctrl+F2</td>
</tr>
<tr>
<td>File Properties...</td>
<td></td>
</tr>
<tr>
<td>1, 000 lines</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

Figure 1-6. File Menu

Edit Menu

The Edit menu (Figure 1-7 on page 1-8):

- allows a redo or undo of the last operation
- cuts, copies, pastes or deletes information
- sets the Pan or Zoom mode
- displays the Properties dialog box
- adds a new point
View Menu

The View menu (Figure 1-8) provides access to viewing and hiding the Toolbar, the Status bar, the Layer View, and the CAD View, and activates the window for setting the Point tab, GPS Occupation tab, TS Obs tab, GPS Obs tab, Codes tab and Tape Obs.

Process Menu

The Process menu (Figure 1-9):
- recalculates localization parameters for TopSURV files
- computes coordinates
- sets processing properties
**Window Menu**

The Window menu (Figure 1-10):

- closes the current or all open windows
- arranges open windows in a cascade (stacked) or tile (adjacent) view
- arranges icons
- indicates the current window

![Figure 1-10. Window Menu](image)

**Help Menu**

The Help menu (Figure 1-11) provides access to the context help and information on the current Topcon Link version and build date.

![Figure 1-11. Help Menu](image)

Using the Feedback submenu, you can:

- Send two log files to Topcon Support. These files will be created and attached to e-mail automatically
- Write any question and send an e-mail to Topcon Support
- Visit the Topcon Web Site (http://www.topconpositioning.com/)
Toolbar

The Toolbar for Topcon Link (Figure 1-12) contains buttons for frequently used functions.

Upon startup, the Toolbar displays beneath the menu bar.

- To display or hide the Toolbar, click View ▶ Toolbar. A check mark indicates the Toolbar is visible.
- To move the Toolbar menu, click the bar to the left of the Open icon, then drag the Toolbar to a new location and release the mouse button.

![Figure 1-12. Toolbar](imageURL)

Table 1-2 describes the various Toolbar icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Open Icon](imageURL) | Open – Opens a file.  
1. Click the button to display the Open dialog box.  
2. Select the name of file and/or select a path or folder on the hard disk drive, local area network, or store media.  
3. Click Open. |
| ![Save Icon](imageURL) | Save – Saves files to the current directory |
| ![Save As Icon](imageURL) | Save As – Saves files as a different file |
| ![Import Icon](imageURL) | Import File from Device – Collects the observed files from TPS GPS+ receivers, TPS controllers, CE-based or Conventional or Robotic Total Stations.  
1. Click the button to display the Import file from device dialog box.  
2. Select the device and click Next.  
See “Importing Files” on page 2-1 for more details. |
| ![Export Icon](imageURL) | Export to Device – Exports data from files to a TPS controller or a CE-based, Conventional, Robotic Total Station, and an Option Authorization File (OAF) to a TPS receiver.  
1. Click the button to display the Export to Device dialog box.  
2. Select the device and click Next.  
See “Exporting an OAF to TPS Receivers” on page 2-32 for more details. |
### Table 1-2. Toolbar Icon Functions (Continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Convert Files – Displays the Convert File dialog box. See page 3-4 for details.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Cut – Removes the marked area or text from the page, placing it on the Windows® clipboard.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Copy – Copies text from the page, placing it on the Windows clipboard.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Paste – Places selected text on the Windows clipboard.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Undo – Reverses the results.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>Redo – Returns the results.</td>
</tr>
</tbody>
</table>
| ![Icon](image7.png) | Add Point – Adds a point to the opened file.  
1. Click the button to display the *Add point* dialog box.  
2. Enter the point name, coordinates, and codes.  
3. Click OK. |
| ![Icon](image8.png) | Zoom In – Switches the active CAD view into zoom mode. |
| ![Icon](image9.png) | Zoom Out – Switches the active CAD view into zoom mode. |
| ![Icon](image10.png) | Zoom Back – Zooms back on the CAD view. |
| ![Icon](image11.png) | Restore All – Fits all data in the active CAD view into the viewable extents of the active view. |
| ![Icon](image12.png) | Pan – Changes the cursor to a “hand” to “grab” and move the CAD view. |
| ![Icon](image13.png) | CAD View – Opens and closes a graphical view of linework with the associated points and lines. |
| ![Icon](image14.png) | Performs a Localization – views, edits and recalculates localization parameters saved in a TopSURV file.  
1. Click the button to display the *Localization* dialog box.  
2. Change the status of a localization point in the Use column, remove a point by pressing Remove Point, or add a point by pressing Add Point. |
The status bar displays various informative messages about current Topcon Tools activities and data.

Double-click the boxes to display the pop-up lists that provide quick conversion to other units, coordinate types, and systems (Figure 1-13).

- linear and angular units
- coordinate type and coordinate system

Details on file conversion will be described in sections about editing coordinate files, TS raw data files and TopSurv files.

**Table 1-2. Toolbar Icon Functions (Continued)**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Compute Coordinates of Points – Computes (calculates) the point coordinates in the current file.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Print – Prints the current window or table.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>About Topcon Tools – Displays the About Topcon Tools dialog box.</td>
</tr>
</tbody>
</table>

**Status Bar**

The status bar displays various informative messages about current Topcon Tools activities and data.

Details on file conversion will be described in sections about editing coordinate files, TS raw data files and TopSurv files.

![Figure 1-13. Status Bar and Pop-up Lists](image)
Transferring Files

This chapter describes importing and exporting, or transferring, of files between devices and a computer using Topcon Link.

Importing Files

The following sections describe importing data files from a device, such as Conventional/Robotic Total Station, TPS GPS+ Receiver, TPS Memory Card, TPS Controller, or TPS Digital Level to a PC.

Topcon Link allows the importing of data from Topcon devices in two ways by using the Topcon Link buttons in the toolbar or commands in main menu.

The installation of Topcon Link to the computer creates three additional folders in the computer (Figure 2-1).

![Figure 2-1. Topcon's Devices Folders](image)

To import data from the device using Windows Explorer, click the appropriate folder.

The “Mobile Device” folder is created if Microsoft ActiveSync has been installed in the computer.
Importing From a Receiver

See the Topcon receiver manual for instructions to connect the receiver and the computer.

- Connect the receiver and computer using the RS232 or USB cable, and turn on the receiver.
- If the receiver and the computer are Bluetooth® enabled, connect using Bluetooth.

NOTICE

Before connecting the receiver’s USB port to the computer’s USB port, the TPS USB driver must be installed on the computer. The driver is available on the TPS website (http://www.topconpositioning.com/software/updates.html).

Using Windows Explorer

1. Open Windows Explorer and click the Topcon Receiver folder. The right panel of the window displays the automatic start of searching for Topcon receivers connected to any of the computer ports (COM and USB) (Figure 2-2).

2. When finished, all receivers connected to the computer ports (Figure 2-2) display.
3. To stop searching for receivers when the desired receiver has been found, click Stop. Only the discovered receivers will display.

![Figure 2-3. Break Of Searching Receivers](image)

4. To update information about the receivers connected to the computer port, click Search for connected receivers.

5. To view information about the receiver (Figure 2-4), right-click the desired receiver and select the Properties option.

6. To view the collected raw file, click on the desired receiver.

![Figure 2-4. Receiver Properties](image)

7. To import the file(s) from the receiver to a folder, select the desired file(s) and copy to the folder using drag-and-drop method (Figure 2-5).

![Figure 2-5. Start of File Import from the TPS Receiver/Import in Progress](image)
Using Topcon Link

1. To start Topcon Link, click the Import from Device button on the Toolbar.

2. From the left panel of the Import from Device dialog box, double-click Topcon Receivers (Figure 2-6).

3. The program automatically searches for Topcon receivers connected to the computer ports (COM and USB). When finished all receivers connected to the computer ports (Figure 2-7) display.
4. To view information about the receiver, right-click the desired receiver and select the Properties option (Figure 2-8).

![Figure 2-8. Receiver Properties](image)

5. In the right panel of the Import From Device window, navigate to and select, or create, a folder to save the files (Figure 2-9).

6. To view the collected raw file, double click (or click Select in the pop-up menu) the desired receiver. To import the file(s) from the receiver to the computer and to save in the selected folder, highlight the desired file(s) and click the double arrows (Figure 2-9).

7. The import in progress displays (Figure 2-9).

![Figure 2-9. Select the Raw Data File to Import and View Import Progress](image)
Importing TPS Controller Files

Before importing data from a TPS Controller or CE-based Total Station to Topcon Link, install Microsoft® ActiveSync® onto the computer. ActiveSync establishes a connection between the computer and a mobile device, such as a TPS Controller or CE-based Total Station. The mobile device must have the Windows® CE operating system. ActiveSync is available as a free download from the Microsoft website (http://www.microsoft.com).

To establish a connection between the computer and TPS Controller, do the following:

1. Using an RS-232 interface cable, connect the TPS Controller/CE-based Total Station to the serial interface port on the computer.
2. Turn on the TPS Controller/CE-based Total Station and the computer.
3. Start Microsoft ActiveSync.
4. Click Next on the Get Connected dialog box (Figure 2-10).

![Figure 2-10. ActiveSync – Get Connected](image)

5. The computer establishes a connection with the TPS Controller/CE-based Total Station. If the TPS Controller/CE-based Total Station is switched on (Figure 2-11 on page 2-7), and the correct COM Port is selected, the following dialog box displays.
6. The system tray also displays a **Green Connection Status** icon, indicating a successful TPS controller/CE-based Total Station-to-computer connection.

**NOTICE**

TPS Controllers keep *.tsv files as database format files; this format cannot be stored on a computer. When importing these files from a TPS Controller/CE-based Total Station to a computer, Topcon Link converts them to an accessible file format (*.tlsv) before saving. Topcon Link/CE-based Total Station must be used to convert the correct *.tsv files to the desired format.

**CAUTION**

To avoid data loss while exporting *.tsv files from a TPS Controller/CE-based Total Station to a computer, use only Topcon Link.
Microsoft ActiveSync Settings

If the computer has only one COM Port:

1. Start Microsoft ActiveSync.
2. Click File ➤ Connection Settings.
3. On the Connection Settings dialog box (Figure 2-12), click and enable the following parameters.
   - allow network (Ethernet) and Remote Access Service (RAS) server connection with this desktop computer
   - the show status icon in Task bar

![Connection Settings](image)

Figure 2-12. Connection Settings

**NOTICE**

ActiveSync does not request the COM Port after disconnecting the TPS Controller/CE-based Total Station from the computer. The COM Port connects the computer with a TPS GPS+ receiver or Conventional/Robotic Total Station.
If there are two or more COM Ports on the computer:

1. Start Microsoft ActiveSync.
2. Click File > Connection Settings.
3. On the Connection Settings dialog box (Figure 2-13), set the following parameter.
4. Click and enable the “Allow serial cable or infrared connection to this COM port”
5. Select the desired COM port from the drop-down list (usually COM 1).

![Connection Settings dialog box](image)

Figure 2-13. Click Get Connected

*Microsoft ActiveSync* requests the COM Port after disconnecting the controller and computer. The COM Port is available only for devices that use the Windows CE operating system.

**TIP**

Use separate COM Ports for computer-to-TPS controller (or CE-based Total Station) connections and computer-to-TPS Receiver/Conventional/Robotic Total Station connections.

When reconnecting the computer and TPS Controller/CE Based Total Station, use the same serial interface port set in the *Connection Settings* dialog box.
**Using Windows Explorer**

1. Follow the manufacturer’s directions for connecting the computer and a TPS Controller.

2. Be sure (check) that Microsoft ActiveSync is installed on the computer and a successful computer-to-device connection is established. A system tray displays a green **ActiveSync circle**.

3. Open Windows Explorer and click the **Mobile Device** folder. The right panel of the window displays the contents of the TPS Controller (Figure 2-14).

4. To import the (*.tsv) file(s) from the TPS Controller and to convert to the (*.tlsv) file(s), copy the selected *.tsv file(s) to the desired folder in which to save the downloaded file(s).

5. When the process of sending the file(s) from the TPS Controller to the computer starts, the **Copy & Convert Progress** (Figure 2-15) window displays the import and conversion in progress.

6. The downloaded file(s) will be saved in the desired folder.
Using Topcon Link

1. Follow the manufacturer's directions for connecting the computer and a TPS Controller.

2. Be sure (check) that Microsoft ActiveSync is installed on the computer and a successful computer-to-device connection is established. A system tray displays a green ActiveSync circle.

3. Start Topcon Link, then click File ▶ Import from Device.

4. Double-click the Mobile Device in the Import from Device window (Figure 2-16).

5. Select the folder where the (*.tsv) file(s) is saved in the TPS Controller. To view file properties (Figure 2-17), right-click on the file and select Properties on the pop-up menu.
6. In the right panel of the *Import From Device* window, navigate to and select or create, the folder to save the files.

![Figure 2-18. Select File](image)

7. To import the (*.tsv) file from the TPS Controller, to convert to the (*.tlsv) file, or to save in the selected folder, press the double arrows.

8. When the process of sending the file from the TPS Controller to the computer begins, the Status bar displays the import progress.

**Importing From Total Station**

When importing files from conventional or robotic Total Stations (TS), the file transfer will be initiated from the TS after connecting to the computer. Refer to the Topcon total station’s manual for connecting the computer and a total station.

**Using Windows Explorer**

1. Open Windows Explorer and click the *Topcon Total Stations* folder. The right panel of the window displays the ‘Add New Station’ icon. To add a new device, right click this icon and select *Create Station* on the pop-up menu.

![Figure 2-19. Creating a New Station in Windows Explorer](image)
2. In the General tab of the Create Station dialog box, enter the following information and click OK.
   - Name – enter a unique name for the device
   - Notes – enter any necessary notes
   - Port – select the COM Port the device connects to
   - Model and Software – enter model number or software name
3. In the Advanced tab of the Create Station dialog box, enter the baud rate, parity, data bits, stop bits, and protocol used for communication with the TS (Figure 2-20).

![Figure 2-20. Total Station Properties](image)

4. A new icon for the Total Station displays in the right panel (Figure 2-21), and a new sub-folder will be created in the Topcon Total Stations folder of Windows Explorer. To change the properties (communication parameters, name, model, and so on) for this Total Station, right-click on the icon and select Properties on the pop-up menu. The Station Properties dialog box for the Total Station is identical to the Create Station dialog box for the new Total Station.

![Figure 2-21. Changing Total Station Properties](image)
5. To import coordinates or a measurement file from this Total Station, double-click on the icon and ‘file.txt’ will be copied to the folder where the downloaded file is saved.

6. Follow all the steps given in the Download File From Total Station (Figure 2-22) window to prepare the Total Station for importing the file. Select a desired file in the Total Station for downloading to the computer.

7. Click the Start button on the Download File From Total Station (Figure 2-22) window. When ready to send the data, press the F3 key for “yes” to begin the process.

8. When the process of sending data from the Total Station to the computer begins, the status changes to “Downloading...” in the Download File From Total Station window.

9. The downloaded file is saved in the desired folder.

Using Topcon Link

1. Start Topcon Link, then click File → Import from Device.

2. Double-click the Topcon Total Stations in the Import from Device dialog box (Figure 2-23).
3. To add a device, right click or double click the icon ‘Add New Station’ and select Create Station (Figure 2-24) from the pop-up menu.

4. In the General tab of the Create Station dialog box, enter the following information and click OK.
   - Name – enter a unique name for the device
   - Notes – enter any necessary notes
   - Port – select the COM Port the device connects to
   - Model and Software – enter model number and software name

5. In the Advanced tab of the Create Station dialog box, enter the baud rate, parity, data bits, stop bits, and protocol used for communication with the TS.
6. A new icon for the Total Station displays (Figure 2-26) in the Import from Device dialog box. To change the properties (communication parameters, name, model, and so on), right click on the icon and select Properties on the pop-up menu. The Station Properties dialog box for the Total Station is identical to the Create Station dialog box for the new Total Station.

![Figure 2-26. Changing the Total Station Properties](image)

7. In the right panel of the Import From Device dialog box (Figure 2-27), navigate to and select, or create, the folder in which to save the files.

8. To import coordinates or measurement file from the Total Station, double-click the icon and select ‘file.txt’ and click the double arrows.

![Figure 2-27. Select File](image)

9. Follow all the steps given in the Download File From Total Station dialog box (Figure 2-28 on page 2-17) to prepare the Total Station for importing files. Select a desired file in the Total Station for downloading to the computer.
10. Click the **Start** button on the *Download File From Total Station* (Figure 2-28) window. When ready to send the data, press the F3 key for “yes” to begin the process.

11. When the process of sending data from the Total Station to the computer begins, the status changes to “Downloading...” in the *Download File From Total Station* dialog box.

**Importing From Digital Level**

When importing files from a Digital Level (DL), the file transfer will be initiated from the DL after connecting to the computer. See the Topcon Digital Level’s manual for connecting the computer and Digital Level.

**Using Windows Explorer**

1. Open Windows Explorer and click the *Topcon Digital Levels* dialog box (Figure 2-29). The right panel of the window displays the *Add New Digital Level* icon. To add a new device, right click this icon and select *Create Digital Level* on the pop-up menu.
2. Click the Create Digital Level dialog box (Figure 2-30) and enter the following information.
   • name – enter a name for the device
   • port – enter a port to connect the device, usually COM
   • baud rate – enter a baud rate to communicate with the DL
   • parity – enter a parity to communicate with the DL

   ![Figure 2-30. Digital Level Properties](image)

3. A new icon for the Digital Level displays (Figure 2-31) in the right panel, and a new sub-folder will be created in the Topcon Digital Levels folder of Windows Explorer. To change the properties (communication parameters, name, model, and so on) for this Digital Level, right-click on the icon and select Properties on the pop-up menu. The Digital Level Properties dialog box for the Digital Level is identical to the Create Digital Level dialog box for the new Digital Level.

   ![Figure 2-31. Changing Digital Level Properties](image)
4. To import a file from this Digital Level, double-click on the icon and ‘file.dl’ will be copied to the desired folder to save the downloaded file.

5. Follow all the steps given in the Download File From Digital Level window to prepare the Digital Level for importing files. Select a desired file in the Digital Level for downloading to the computer.

![Figure 2-32. Start of File Import from the Total Station](image)

6. When the process of sending data from the Digital Station to the computer begins, the status changes to “Downloading...” in the Download File From Digital Level window. The downloaded file is saved in the desired folder.

Using Topcon Link

1. Start Topcon Link, then click **File ▶ Import from Device**.
2. Double-click the **Topcon Digital Levels** in the **Import from Device** dialog box (Figure 2-33).

![Figure 2-33. Import From Device Window](image)
3. To add a device, select *Add New Digital Level*, then select *Digital Level* on the pop-up menu (Figure 2-34).

![Figure 2-34. Creating a New Digital Level](image)

4. Click the *Create Digital Level* dialog box (Figure 2-35) and enter the following information.
   - name – enter a name for the device
   - port – enter a port to connect the device, usually COM
   - baud rate – enter a baud rate to communicate with the DL
   - parity – enter a parity to communicate with the DL

![Figure 2-35. Digital Level Properties](image)

5. A new icon for the Digital Level displays (Figure 2-36 on page 2-21) in the *Import from Device* dialog box. To change the properties (communication parameters, name, model, and so on) for this Digital Level, right-click on the icon and select *Properties* on the pop-up menu. The *Digital Level Properties* dialog box for the Digital Level is identical to the *Create Digital Level* dialog box for the new Digital Level.
6. In the right panel of the Import From Device dialog box, navigate to and select, or create, the folder to save the files.

7. To import a file from this Digital Level to the computer, double-click on the icon. On the left panel of the Import from Device window select the file ‘file.dl’ and click the double arrows.

8. Follow all the steps in the Download File From Digital Level dialog box (Figure 2-37) to prepare the Digital Level for importing the file. Select a file in the Digital Level for downloading to the computer.

9. When the process of sending data from the Digital Station to the computer starts, the status changes to “Downloading...” in the Download File From Digital Level dialog box.
Import from a Memory Card

To import data from a Memory Card to the computer, insert the receiver’s memory card (SD card) with the label side down into the computer’s SD card slot.

Using Windows Explorer

1. Open Windows Explorer and click the Topcon Memory Cards folder. If the SD card was formatted in the receiver’s file system, the disk, which designates the Topcon Memory Card, will be displayed in red:

   ![Disk in Red]

   If the SD card was formatted in any other system, the icon of the memory card will be displayed in gray:

   ![Disk in Gray].

   In this case, Topcon Link does not read files stored in the card.

2. Click the disk in the left or right panel of Windows Explorer. Topcon Link checks file system of this CD card and displays a list of *.tps files (Figure 2-38).

3. To import file(s) from the Topcon Memory Card to a folder on the computer, select the desired file(s) and copy them to the folder using the drag-and-drop method.

4. To format Topcon Memory Cards in the receiver’s file system, right-click the disk in the left panel of Windows Explorer, select Format from the pop-up menu, and click Ok in the Format flash card window (Figure 2-39 on page 2-23).
Importing Files

Using Topcon Link

1. Start Topcon Link and open a job, then click **File ▸ Import from Device**.

2. Click **Memory Card** in the **Import from Device** dialog box. If the SD card was formatted in the receiver’s file system, the disk, which designates the Topcon Memory Card, will be displayed in red (Figure 2-40).

3. To view the collected raw files stored in the Memory Card, double-click the disk. A list of *.tps files is displayed after checking the file system of this CD card.
4. To import the file(s) from the Memory Card to the computer and to save them in the selected folder, highlight the desired file(s) and click the double arrows (Figure 2-41).

5. If the SD card was formatted in any other system, the icon of the memory card will be displayed in gray. In this case, Topcon Link does not read the files stored in the card. To format the Memory Card, double-click on the icon and click Yes.
Exporting Files To Device

The following sections describe exporting files from a computer (Figure 2-42).

- coordinate data files to a Conventional/Robotic Total Station
- any files to a TPS Controller
- an Option Authorization File (OAF) to a TPS GPS+ Receiver

Data can be exported to Topcon devices by using the Topcon Tools buttons in the toolbar. Three additional folders are created.

To export data to a Total Station or TPS Controller using Windows Explorer, click the appropriate folder.

Figure 2-42. Topcon’s Devices Folders
Exporting to a TPS Controller

1. Follow the manufacturer’s directions for connecting the computer and a TPS Controller.
2. Check that Microsoft ActiveSync is installed on the computer and a successful computer-to-device connection is established. The system tray displays a green ActiveSync circle.

Using Windows Explorer

1. Open Windows Explorer and click the Mobile Device folder. The right side of the window displays the contents of the Topcon Controller (Figure 2-43). Select the folder in the TPS Controller where the exported file will be saved, then select the desired file in the computer.

![Figure 2-43. Selecting the Folder in the TPS Controller](image)

2. To export a file from the computer to the TPS Controller, copy the file to the selected folder in the TPS Controller.
3. When exporting a TopSURV database file(s) from the computer to the TPS Controller, Topcon Tools converts (*.tlsv) job files to the *.tsv job format for TopSURV database files.
4. In the process of sending the file(s) from the computer to the TPS Controller, the *Copy & Convert Progress* window displays (Figure 2-44) the export and conversion progress.

**Using Topcon Link**

1. Start Topcon Link. To export information to the device, click *File ➤ Export to Device*.

2. Double-click the *Mobile Device* in the right panel of the *Export to Device* dialog box (Figure 2-45). Select the folder in the TPS Controller where the exported file will be saved. In the left panel of the *Export to Device* window, select a file for export. Click the double arrows.
Exporting to a Total Station

See the Topcon Total Station’s manual for connecting the computer and a total station.

Using Windows Explorer

1. Open Windows Explorer. The Topcon Total Stations dialog box displays (Figure 2-46). To add a new device, right-click on the Add New Station icon, and select Create Station on the pop-up menu.

![Figure 2-46. Creating a New Station in Windows Explorer](image)

2. In the General tab of the Create Station dialog box (Figure 2-47 on page 2-29), enter the following information and click OK.

   - Name – enter a unique name for the device
   - Notes – enter any necessary notes
   - Port – select the COM Port that the device connects to
   - Model and Software – enter model name and software type

3. In the Advanced tab of the Create Station dialog box (Figure 2-47 on page 2-29), enter the baud rate, parity, data bits, stop bits, and protocol used for communication with the TS.
4. A new icon for the Total Station displays (Figure 2-48 on page 2-29) in the right panel. A new sub-folder is created in the *Topcon Total Stations* folder of Windows Explorer. To change the properties (communication parameters, name, model, and so on) for this Total Station, right-click on the icon and select **Properties** on the pop-up menu. The **Station Properties** dialog box for the Total Station is identical to the **Create Station** dialog box for a new Total Station.

5. To export a coordinate file from the computer to the Total Station, copy the selected file to the Total Station.

6. Follow the instructions in the **Upload File(s) to Total Station** dialog box (Figure 2-49 on page 2-30) to prepare the Total Station for exporting the file.
7. When ready to send the file, press the **F3** key for “yes” on the Total Station. Click the **Start** button on the **Upload File(s) To Total Station** dialog box (Figure 2-49) to begin the process.

![Figure 2-49. Exporting a Coordinate File to the Total Station](image)

8. When the process of the sending data from the computer to the Total Station starts, the status changes to “Performing the transfer...” in the **Upload File(s) to Total Station** window.

9. The exported file is saved in the Total Station.

**Using Topcon Link**

1. Start Topcon Link. To export a coordinate file to a Total Station, click **File ▶ Export to Device**.

2. Double-click the **Topcon Total Stations** in the right panel of the **Export to Device** dialog box, select the desired Total station and double click the icon (Figure 2-50 on page 2-31). In the left panel of the **Export to Device** window select a coordinate file for export.
3. Follow all the steps given in the *Upload File(s) to Total Station* dialog box (Figure 2-51) to prepare the Total Station for exporting file.

4. When ready to send the file, press the F3 key for “yes” on the Total Station. Click the **Start** button on the *Upload File(s) To Total Station* (Figure 2-28) window to begin the process.

5. When the process of sending data from the computer to the Total Station starts, the status changes to “Performing the transfer...” in the *Upload File(s) to Total Station* window.

6. The exported file is saved in the Total Station.
Transferring Files

Exporting an OAF to TPS Receivers

Topcon Positioning System issues an Option Authorization File (OAF) to enable the specific options purchased for a TPS receiver. An OAF allows each receiver to be customized based on particular needs. Use the following steps to load an OAF from the computer to a TPS receiver.

1. Open Windows Explorer and click the Topcon Receiver folder. The right panel of the window displays (Figure 2-52) and automatically begins searching for Topcon receivers connected to any of the computer ports (COM and USB).

![Figure 2-52. Searching for Topcon Receivers in Windows Explorer](image)

2. When finished, all receivers connected to computer ports will display (Figure 2-53). Right-click on the desired receiver and select the "Transfer options file" option.

![Figure 2-53. Selecting ‘Transfer Options File’ option](image)

3. On the Open dialog box, navigate to and select the OAF file for this TPS receiver, then click Open. The new receiver option will load onto the receiver and the Option Manager table will update (Figure 2-54 on page 2-33).
Exporting an OAF to TPS Receivers

Figure 2-54. Select OAF to Upload
Converting Files

Topcon Link™ converts files from:

- Coordinate file formats:
  - Topcon Total Station (GTS-7, FC-4, FC-5, GTS-210/310-10, GTS-210/310-12)
  - Char-delimited (Name, Lat, Lon, H, Code; Name, N, E, Z, Code; Name, E, N, Z, Code; Custom)
  - TopSURV Coordinates
  - TDS (CR5)
  - Topcon XML Points (*.xml)
  - Land XML Points (*.xml)

- Measurement file formats from Topcon Total Station raw data formats (GTS-6, GTS-6 No Station Raw, GTS-7, GTS-7+, FC-5, GTS-210/310, Custom TSRaw)

- TS Raw Data Files
  - Land XML files (*.xml)
  - Topcon XML files (*.xml)

- TopSURV PC Job

- Topcon XML file format (XML)

- GPS Obs file
  - Topcon Vector
  - Custom Vector Format
  - TDS RW5 GPS Obs
  - Topcon XML GPS Obs

- GPS+ raw measurements file formats
  - RINEX
  - Compact RINEX
Converting Files

- TPD (Topcon Positioning Data)
- TPS / JPS
- TDS Raw Data Files
- Geoid file
- Localization file
- Road files
- Design (*.tn3, *.dwg, *.dxf, *.xml)
- Topcon DL Obs
- X-Section Template
- SHP file
- Code Library (*.dbf, *.tdd, *.xml)

Topcon Link converts files to:

- Any coordinate file to:
  - Any other coordinate file
  - Topcon XML
  - TopSURV PC
  - DXF, DWG, LandXML
  - SHP

- Any measurement file to:
  - Any other measurement file
  - Any coordinate file
  - DXF, DWG, LandXML
  - SHP
  - Topcon XML
  - TopSURV PC

- TopSURV Job PC file to:
  - Any coordinate file
  - Any measurement file
  - SHP
– DXF, DWG, LandXML
– Topcon XML
– GPS Vector file
– Localization file (if the TopSURV file contains pairs of point coordinates in WGS84 and local system for each Control point)
– Cut Sheet file (if the TopSURV file includes Stakeout points)
– Any Road file (if the TopSURV file includes road data)
– An X-Section Template file (if the TopSURV file includes an X-section template)

• Topcon XML file to:
  – Any coordinate file
  – Any measurement
  – DXF, DWG, LandXML
  – SHP
  – TopSURV PC Job

• GPS+ TPS / JPS files and TPD files to
  – RINEX file
  – Compact RINEX file

• RINEX file to:
  – TPD file
  – Compact RINEX file

• Compact RINEX file to:
  – TPD file
  – RINEX file

• TSD Raw Data File containing measurement file from a Total Station:
  – Any coordinate file
  – Any measurement file
  – GIS (Shape, LandXML, DXF)
  – Topcon XML
Converting Files

- TopSURV PC Job

- TDS Raw Data File containing RTK data:
  - Any coordinate file
  - Any measurement file
  - DXF, DWF, LandXML
  - SHP
  - Topcon XML
  - TopSURV PC Job
  - Surface file

- Geoid file to Topcon Geoid file

- Localization file to TopSURV PC Job

- Surface file to DXF, DWG, LandXML, TopSURV PC Job

- Feature File to TopSURV PC Job file

- Road file to a TopSURV file or other road file format

- X-Section Template file to a TopSURV PC Job file or other x-section template file format

- DXF, DWG, LandXML
  - Any coordinate file
  - Any other DXF, DWG, LandXML file
  - TopSURV PC Job
  - Surface file

1. To convert a file from one format to another, click File ➤ Convert to File. The Convert File dialog box displays (Figure 3-1).

![Figure 3-1. Convert File Dialog Box](image)

- The left panel displays the source file information.
- The right panel displays the destination file information after the conversion.
2. In the left panel, select file type (Figure 3-2).

3. Click Browse (“...”) and select the file for conversion in the Open for convert dialog box (Figure 3-3).

4. Click Open. The path of the source file displays in the Source field (Figure 3-4).

5. In the right panel, enter the destination file name and type.
6. Click **Browse (“…””)** and select or create a folder in the **Select a file** dialog box, then select the destination file type and enter the destination file name. Click **Select** (Figure 3-5).

![Figure 3-5. Select A File](image)

7. Click **Advanced Options** to display further conversion parameters. Enter the desired information (Figure 3-6).

![Figure 3-6. Convert File – Advanced Options](image)

The left panel displays parameters and values used in the field operations. The right panel displays parameters and values after the conversion.

8. Click **Convert** in the **Convert File** dialog box to start the file conversion (Figure 3-6 on page 3-6).

Conversion operations depend on the format type of the source and the destination files. See “Converting Coordinate Files” on page 3-10 for specific conversion parameters information.
Creating a Custom Projection

When converting data formats, you can use a projection from a pre-defined list or create a user-defined projection.

1. To create a user-defined projection, in the projection field of the Convert File dialog box, click Custom.

2. In the Custom Projection List dialog box, click Add (Figure 3-7).

![Figure 3-7. Custom Projection List]

3. In the New Custom Projection dialog box, enter the following information for the new projection (Figure 3-8 on page 3-8):
   - enter a new projection name
   - select a projection type
   - select the desired datum
   - enter the parameters of the user-defined projection
   - enter the region name and note

4. To add the user-defined projection to the list of projection, click Ok.
Creating a Custom Datum

When converting data formats you can use a datum from a pre-defined list or create a user-defined datum.

1. To create a user-defined projection, in the datum field of the Convert File dialog box, click **Custom**.
2. In the **Custom Datums List** dialog box, click **Add** (Figure 3-9).
3. In the **New Custom Datum** dialog box, enter the following information for the new projection (Figure 3-10).

   - enter the new datum name
   - select the desired ellipsoid
   - Enter the values of DX, DY, DZ, RX, RY, RZ and Scale (which are all zeros by default)

![Figure 3-10. Enter Custom Datums Parameters](image)

**NOTICE**

These parameters (shifts, rotations and scale) specify a coordinate transformation from the newly created reference datum to WGS84 according to the following equations:

\[
\begin{bmatrix}
X_{WGS-84} \\
Y_{WGS-84} \\
Z_{WGS-84}
\end{bmatrix}
= \begin{bmatrix}
DX \\
DY \\
DZ
\end{bmatrix}
+ (1 + \text{Scale} \cdot 10^{-6}) \cdot
\begin{bmatrix}
1 & RZ & -RY \\
-RZ & 1 & RX \\
RY & -RX & 1
\end{bmatrix}
\begin{bmatrix}
X_{\text{new - datum}} \\
Y_{\text{new - datum}} \\
Z_{\text{new - datum}}
\end{bmatrix}
\]

4. To add the user-defined projection to the list of projections, click **Ok**.
Converting Coordinate Files

If converting a coordinate type file, specify the following parameters in the left/right panels:

- The file format (Figure 3-11).

- In the left panel, enable Orthometric Height when the file uses orthometric heights (Figure 3-12).

- In the left panel, enable Control to fix the coordinates of points when converting the file to a *.tlsv file (Figure 3-13).

- In the right panel, enable Orthometric Height to calculate orthometric heights for the converted points (Figure 3-14).

- In the right panel, set the Geoid model.
  1. Click Geoids List (Figure 3-15).
2. On the Geoids List dialog box, click Add (Figure 3-16).

![Figure 3-16. Geoids List Dialog Box](image)

3. Select the desired *.bin file in Open dialog box and click Open (Figure 3-17).

![Figure 3-17. Open window](image)

4. Click Close (Figure 3-18).

![Figure 3-18. Geoids List](image)

- In the right panel, select a geoid model (Figure 3-19).

![Figure 3-19. Select Geoid Model](image)
TopSURV Coordinates and Custom Text Format Parameters

To convert TopSURV Coordinates or Custom Text formats, select the following.

- A projection name for the coordinate type (Figure 3-20).

![Figure 3-20. Projection List](image)

- Or a Datum for Lat, Lon, H coordinate type (Figure 3-21).

![Figure 3-21. Datum List](image)

- Linear units (Figure 3-22).

![Figure 3-22. Linear Units List](image)
**Name,Lat,Lon,H,Code Format**

**Parameters**

To convert Name, Lat, Lon, H, Code formats, select the following:

- Datum (Figure 3-23).

![Figure 3-23. Datum List](image)

- Linear units (Figure 3-24).

![Figure 3-24. Linear Unit List](image)

**Other Coordinate File Types Format**

**Parameters**

To convert GTS-7 Points, FC-4, FC-5, GTS-210/310-10, GTS-210/310-12, Name, E, N, Z, Code or Name, N, E, Z, Code formats, specify the following parameters.

- Projection (Figure 3-25).

![Figure 3-25. Projection List](image)
Converting Files

- Linear units (Figure 3-26).

![Linear Unit List](image)

**Figure 3-26. Linear Unit List**

When converting from (the left panel) GTS-7 Points, FC-4, FC-5, GTS-210/310-10 and GTS-210/310-12 file formats, enter the Grid and Ground transformation parameters using the following procedure.

1. Click and enable the **Grid->Ground Parameters** check box (Figure 3-27).

![Grid->Ground Parameters](image)

**Figure 3-27. For Ground Coordinate Type, Enable Grid->Ground Parameters**

2. Click the **Grid to Ground Parameters** button.
3. Enter the applicable transformation parameters (Figure 3-28).

![Grid to Ground Parameters](image)

**Figure 3-28. Grid to Ground Parameters**

Depending on the set of known data, the transformation parameters can be computed in two modes:

- using the Control points’ average height
- using the scale factor

4. Click **OK**.

When converting to (the right panel) GTS-7 Points, FC-5 Points, GTS-210/310-10 Points, and GTS-210/310-12 Points file formats, a coordinate file that contains Ground coordinates is created. To convert Ground coordinates to Grid coordinates, see the above procedure.
Converting a TopSURV PC Job

If converting a TopSURV file, specify the following parameters in left/right panels.

In the left panel,

- the File Format (Figure 3-29).

![Figure 3-29. File Format List](image)

In the right panel,

- the File format (Figure 3-30).

![Figure 3-30. File Format List](image)

- the Projection type (Figure 3-31).

![Figure 3-31. Projection List](image)
• the relation between the Grid and Ground coordinates:
  1. Click and enable the Grid->Ground Parameters check box (Figure 3-32).

![Figure 3-32. For Ground Coordinate Type, Enable Grid->Ground Parameters](image)

2. Click the Grid to Ground coordinates button.
3. On the Grid->Ground Parameters dialog box, enter the transformation parameters (Figure 3-33).

![Figure 3-33. Grid->Ground Parameters Dialog Box](image)

Depending on the set of known data, the transformation parameters can be computed in two modes:
– the Control points’ average height
– the scale factor

• the Linear units (Figure 3-34)

![Figure 3-34. Linear Units List](image)

• the Angular units (Figure 3-35)

![Figure 3-35. Angular Units List](image)
• Set the Geoid model.
  1. Click **Geoids List**.
  2. On the **Geoids List** dialog box, click **Add** (Figure 3-36).

![Geoids List Dialog Box](image)

Figure 3-36. Geoids List Dialog Box

3. Select the desired *.bin file in the **Open** dialog box and click **Open** (Figure 3-37).

![Open Window](image)

Figure 3-37. Open Window

4. Click **Close** (Figure 3-38).

![Geoids List](image)

Figure 3-38. Geoids List

• Select the geoid model (Figure 3-39).

![Select Geoid Mode](image)

Figure 3-39. Select Geoid Mode
• Set the order of the coordinates (Figure 3-40).

![Figure 3-40. Coordinate Order List](image)

• Select the Coordinate type (Figure 3-41).

![Figure 3-41. Coordinate Type List](image)

### Converting Total Station Raw Data Files

If converting a Total Station (TS) measurement file, specify the following parameters in the left/right panels.

In the left panel,

• the File format (Figure 3-42).

![Figure 3-42. File Format List](image)
Converting Total Station Raw Data Files

- the Projection type (Figure 3-43).

![Projection List](image)

**Figure 3-43. Projection List**

- the relation between the Grid and Ground coordinates

1. Click and enable the Grid->Ground Parameters check box (Figure 3-44).

![Grid-Ground Parameters](image)

**Figure 3-44. For Grid Coordinate Type, Enable Grid->Ground Parameters**

2. Click the Grid to Ground coordinates button.

3. On the Grid->Ground Parameters dialog box, enter the transformation parameters (Figure 3-45).

![Grid->Ground Parameters Dialog Box](image)

**Figure 3-45. Grid->Ground Parameters Dialog Box**

Depending on the set of known data, the transformation parameters can be computed in two modes:
- the Control points’ average height
- the scale factor

- the order of the coordinates (Figure 3-46).

![Coordinate Order List](image)

**Figure 3-46. Coordinate Order List**
In the right panel,

- the File format (Figure 3-47).

![Figure 3-47. File Format List]

- the Projection type (Figure 3-48).

![Figure 3-48. Projection List]

- the relation between the Grid and Ground coordinates:
  1. Click and enable the Grid->Ground Parameters check box (Figure 3-49).

![Figure 3-49. For Ground Coordinate Type, Enable Grid->Ground Parameters]

  2. Click the Grid to Ground coordinates button.
3. On the **Grid->Ground Parameters** dialog box, enter the transformation parameters (Figure 3-50).

![Figure 3-50. Grid->Ground Parameters Dialog Box](image)

Depending on the set of known data, the transformation parameters can be computed in two modes:

- the Control points’ average height
- the scale factor

- the Linear units (Figure 3-51).

![Figure 3-51. Linear Units List](image)

- the Angular units (Figure 3-52).

![Figure 3-52. Angular Units List](image)

- the Coordinate order (Figure 3-53).

![Figure 3-53. Coordinate Order List](image)
Converting to Custom TSRaw Format

To create an arbitrary text TSRaw file, take the following steps:

1. Select the file format in the right panel (Figure 3-54).

2. Enter other desired settings (see “Converting Total Station Raw Data Files” on page 3-18 for details). Press **Convert**.

3. On the **TSRaw custom format properties** dialog box, select the desired delimiter (Figure 3-55).

4. Select the elements to include in the format from the left column and click the move right button (>>) to add it to the right column (Figure 3-55). Use the move left button (<<) to remove elements from the format.

5. To arrange included elements, select an element in the right column and use the **Move Up/Move Down** buttons.

6. Enter the format name and the format’s file extension.

7. Click **OK** to export the selected file to the created TSRaw file format. Topcon Link will store this format description in the Formats folder.
Converting Topcon XML Files

If converting a Topcon XML file, set the following parameters in the left panel:

- Select the File format (Figure 3-56).

![Figure 3-56. File Format List](image)

If the Topcon XML file contains *Ground* or *Grid* coordinate types, set the Projection, Linear unit, and Angular unit (Figure 3-57).

![Figure 3-57. Projection, Linear Unit, Angular Unit Lists](image)

If the Topcon XML file contains the *Lat, Lon, H* coordinate type, set the Datum, Linear unit, and Angular unit (Figure 3-58).

![Figure 3-58. Datum, Linear Unit, and Angular Unit Lists](image)
Converting Files

- For Ground coordinates enter the relation between the Grid and Ground coordinates:
  1. Click and enable the Grid->Ground Parameters check box (Figure 3-59).

![Figure 3-59. For Ground Coordinate Type, Enable Grid->Ground Parameters](image1)

2. Click the Grid to Ground coordinates button.
3. On the Grid->Ground Parameters dialog box, enter the transformation parameters (Figure 3-60).

![Figure 3-60. Grid->Ground Parameters Dialog Box](image2)

Depending on the set of known data, the transformation parameters can be computed in two modes:
- the Control points’ average height
- the scale factor

Converting Design Files

If converting LandXML, DWF, DWG, or TN3 (Surface) files, select the correct file format in the left/right panel (Figure 3-61).

![Figure 3-61. File Format List](image3)
Converting Localization Files

If converting a Localization file, select the correct file format in the From panel (Figure 3-62).

![Figure 3-62. File Format List](image)

In the right panel,
- Select the file format (Figure 3-63).

![Figure 3-63. Format List](image)
- Specify linear units (Figure 3-64).

![Figure 3-64. Linear Unit Lists](image)
Converting Files

Converting GPS+ Raw Data Files

If converting a GPS+ Raw Data file (TPS, JNS, RINEX, Compact RINEX, TPD), select the correct file format in the *From* panel (Figure 3-65).

![Figure 3-65. File Format List](image)

Converting to SHP Files

If converting a SHP file, specify the following parameters in the left panel.

- Select the file format (Figure 3-66).

![Figure 3-66. File Format List in the Left Panel](image)

- Set the Projection and Linear units (Figure 3-67).

![Figure 3-67. Projection and Linear Unit Lists](image)
Converting to SHP Files

- For Ground coordinates, set the relation between the Ground coordinates and Grid coordinates. See steps 1 through 3 on page 3-24 for this procedure.

If converting to a GIS file, specify the following parameters in the right panel:

- Select the file format (Figure 3-68).

![Figure 3-68. File Format List](image)

- Set the Projection and Linear units (Figure 3-69).

![Figure 3-69. Projection and Linear Unit Lists](image)

- For Ground coordinates, set the relation between the Ground coordinates and Grid coordinates. See steps 1 through 3 on page 3-16 for this procedure.

- Enable Orthometric Height to calculate orthometric heights for the converted points (Figure 3-70).

![Figure 3-70. Orthometric Height](image)
• Enable export of points without codes to the created file and export of linework named vertices as points to the created file (Figure 3-71).

Figure 3-71. Enable Point/Linework Export

• If needed, open a geoid model.
  1. Click **Geoids List**.
  2. On the **Geoids List** dialog box, click **Add** (Figure 3-72).

Figure 3-72. Geoids List Dialog Box

3. Select the desired *.bin file in **Open** dialog box and click **Open** (Figure 3-73).

Figure 3-73. Open Window

4. Click **Close** (Figure 3-74).

Figure 3-74. Geoids List
• Select a geoid model (Figure 3-75).

![Figure 3-75. Select Geoid Model](image1)

**Converting to TPD GPS+ Raw Data Files**

If converting to a TPD GPS+ Raw Data file, select the correct file format in the To panel (Figure 3-76).

![Figure 3-76. File Format List](image2)
Converting to RINEX/Compact RINEX GPS+ Raw Data Files

If converting to a RINEX/Compact RINEX GPS+ Raw Data file, set the following parameters in the To panel:

- Select the File format (Figure 3-77).

  ![Figure 3-77. File Format List](image.png)

- Click **GLONASS** to include or exclude raw GLONASS data measurements/ephemeris data (Figure 3-78).
- Click **L1** and/or **L2** to include or exclude L1 or L2 raw data measurements (Figure 3-78). If both fields are disabled (unchecked), Topcon Link creates only a navigational file (*.0?o).

![Figure 3-78. RINEX/Compact RINEX Advanced Options – Enabled](image.png)
Converting Geoid Files

If converting a Geoid file, select the correct file in the From panel (Figure 3-79).

Figure 3-79. Geoid File Format

Converting to Topcon Geoid Files

Geoid files can be converted to the Topcon Geoid file format for use in Topcon Tools and TopSURV.

If converting to a Topcon Geoid file, set the following parameters in the To panel:

- Select the File format (Figure 3-80).

Figure 3-80. Geoid File Format
• Specify positions for the points limiting the use of this geoid model (Figure 3-81).

![Figure 3-81. Point Limits](image)

NOTE: Enter latitudes and longitudes in the following format (Figure 3-82).

\[ \text{dd}^\circ \text{ mm}' \text{ ss}'' \]

![Figure 3-82. Latitude and Longitude Format](image)

**TIP**

Latitudes are positive for the Northern Hemisphere.
Longitudes are positive for the Eastern Hemisphere.

**Converting Code Library Files**

If converting a Code Library file, select the correct file in the *From* and *To* panels (Figure 3-83).

![Figure 3-83. Feature File Format](image)
Converting to GPS Observation Files

A TopSURV PC Job can be converted to any GPS Obs file.

Converting to GPS Observation Files

If converting to a Topcon Vector format, in the To panel, select the file format and set linear units (Figure 3-84).

![Figure 3-84. GPS Vector File Format and Linear Units](image)

See Appendix C for more details.

Converting to Custom Vector Files

To create an arbitrary text Vector File, take the following steps:

1. Set the File format and linear units (Figure 3-85).

![Figure 3-85. Custom Vector File Format and Linear Units](image)

2. Press Convert.

3. On the Custom vector format properties dialog box, select the Delimiters from the drop-down lists (Figure 3-55 on page 3-22).

4. Select the elements to include in the format from the left column and click the move right button (>>) to add it to the right column (Figure 3-55 on page 3-22). Use the move left button (<<) to remove elements from the format.
5. To arrange included elements, select an element in the right column and use the **Move Up/Move Down** buttons.

6. Click **OK** to export the selected file to the created GPS vector file format. Topcon Link will store this format description in the Formats folder.

### Converting Cut Sheet Files

You can convert a TopSURV PC Job, to a Cut Sheet Standard File and to a Cut Sheet User Defined File.

#### Creating Cut Sheet Standard Files

In converting to Cut Sheet Standard File, set the following parameters in the **To** panel.

- Select the File format (Figure 3-87).

![Figure 3-86. Select Delimiters and Add Elements](image)

![Figure 3-87. Cut Sheet File Format](image)
• Select the Coordinate type (Figure 3-88).

![Figure 3-88. Coordinate Type List](image)

• If Ground or Grid coordinate type is selected, set the Projection and Linear unit (Figure 3-89).

![Figure 3-89. Projection and Linear Unit Lists](image)

• If the $Lat, Lon, H$ coordinate type is selected, set the Datum and Linear units (Figure 3-90).

![Figure 3-90. Datum and Linear Unit Lists](image)

• If Ground coordinates selected (Figure 3-50 on page 3-21), enter the relation between the Grid and Ground coordinates:

1. Click and enable the Grid->Ground Parameters check box (Figure 3-91).

![Figure 3-91. For Ground Coordinate Type, Enable Grid->Ground Parameters](image)

2. Click the Grid to Ground coordinates button.
3. On the **Grid->Ground Parameters** dialog box, enter the transformation parameters (Figure 3-92).

![Figure 3-92. Grid->Ground Parameters Dialog Box](image)

Depending on the set of known data, the transformation parameters can be computed in two modes:
- using the Control points' average height
- using the scale factor

- Set linear units (Figure 3-93).

![Figure 3-93. Linear Units List](image)

- Enable **Orthometric Height** to calculate orthometric heights for the converted points (Figure 3-94).

![Figure 3-94. Orthometric Height](image)

- Set the Geoid model.
  1. Click **Geoids List**.
  2. On the **Geoids List** dialog box, click **Add** (Figure 3-95).

![Figure 3-95. Geoids List Dialog Box](image)
3. Select the desired *.bin file in **Open** dialog box and click **Open** (Figure 3-96).

![Figure 3-96. Open window](image)

4. Click **Close** (Figure 3-97).

![Figure 3-97. Geoids List](image)

- Select a geoid model (Figure 3-98).

![Figure 3-98. Select Geoid Model](image)

**Creating a Cut Sheet User Defined File**

To create an arbitrary Cut Sheet File, take the following steps:

1. Set the File format (Figure 3-99).

![Figure 3-99. Cut Sheet User Defined File Format](image)

2. Enter the desired settings (see “Creating Cut Sheet Standard Files” on page 3-34).

3. Press **Convert**.

P/N 7010-0522
4. In the **Cut Sheet User Defined format properties** dialog box, enter the file’s parameters (Figure 3-100).
   - Delimiters – the separating character type; either Comma, Space, Tab, Semicolon, Tilde, Exclamation, Percent, Bar, Asterisk, or Cap.
   - Design point coordinates, stake out point coordinates, differences between these coordinates, offset direction, offset distance etc.
     - Use the Move Right button (>>) to move selected entries from the left field to the right field. The order of names in the right field must correspond to the order of names in the created file.
     - Use the Move Left button (<<) to move entries out of the right panel
     - Use **Move Up** and **Move Down** to move names in the right panel up and down.

   ![Figure 3-100. Cut Sheet User Defined Format Properties Window](image)

5. Click **Ok**. Topcon Link will store the user-defined format description in the Formats folder.
Converting Road and X-Section Templates File

If converting a Road file and X-Section Templates file, set the following parameters in the From and To panels.

Select the correct file format in the From and To panel (Figure 3-101).

Figure 3-101. Road File Format
Maintaining Files

The following sections discuss opening, viewing, and editing files.

Opening Files

Topcon Link can open files of the following formats and types:

- Coordinate file formats:
  - Topcon Total Station (GTS-7, FC-4, FC-5, GTS-210/310-10, GTS-210/310-12)
  - Char-delimited (Name,Lat,Lon,Ht,Code; Name,N,E,Z,Code; Name,E,N,Z,Code; Custom)
  - TopSURV Coordinates
  - TDS (CR5)
- Measurement file formats from Topcon Total Stations (GTS-6, GTS-6 No Station, Custom, GTS-7, GTS-7+, FC-5, GTS-210/310)
- TopSURV file format (TopSURV files)
- Code Library file

1. To open a file, click File ➤ Open File.
2. To select the file format, use the Format name drop-down list select the file format, if known (Figure 4-1).

![Figure 4-1. File Format](image-url)
3. Click **Open**. The file opens in Topcon Link. Selecting an incompatible file name and file format displays an error message (Figure 4-2). Select the correct file name or format and repeat the process.

![Figure 4-2. Unknown File Format Error Message](image)

**Creating User-defined File Formats**

To open or save a file of arbitrary coordinate format, create and save a user-defined format using the Open dialog box.

1. In the **Open** or **Save as** dialog box, select “Custom Text Format: in the **Format name** drop-down list and type a name for the file in the **File name** field (Figure 4-3). Click **Open/Save**.

![Figure 4-3. Custom Text Format](image)

2. In the **Custom format properties** dialog box, enter the file’s parameters (Figure 4-5 on page 4-3).
   - Delimiters – enter either a Comma, Space, Tab, or Semicolon.
   - Coordinate system – Grid, Ground, or BLH (Lat Lon Format for BLH coordinate system).
   - Coordinate order, codes, notes and fullcodes.
   - Select the desired entry (names, coordinates, codes, notes and FullCodes), then:
     - Use the right arrow button to move entries from the left field to the right field. The order of names in the right field must correspond to the order of names in the opened file.
– Use the left arrow button to move entries out of the right panel and back to the left panel.
– Use the Move Up and Move Down buttons to move names in the right panel up and down.
• Select which FullCodes (Figure 4-4) are used in the file to be opened:

![Figure 4-4. FullCodes Structures](image)

• Enter the format name and the format’s file extension.

![Figure 4-5. Custom Format Properties](image)

3. Click OK. Topcon Link will do the following.
• Store the user-defined format description in the Formats folder.
• Store the format name in the list of the coordinate file formats (Figure 4-6 on page 4-4).
• Open the selected file.

NOTE the following:

1. Points Number should always exist in the right panel.
2. Depending on the type of codes included in the custom format, select the desired option.
   • For fullcodes that contain codes, strings and control codes, use the string code shown in Figure 4-7.

```
CT,663.873,241.411,180.604,20&lamp@corner,30&@
```

Figure 4-7. Example of Coordinate File Format Including Codes, String and Control Code

– After importing this coordinate file to a job, the following information will be displayed (Figure 4-8) at this point in the CAD tab.

![Figure 4-8. Point Properties – CAD tab](image-url)
• Figure 4-9 shows fullcodes that contain codes and attributes.

<table>
<thead>
<tr>
<th>Code</th>
<th>Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1,660.343,257.340,180.903, Base station: Hiper_H_Vert_1_58, TEXT = &quot;&quot;</td>
<td></td>
</tr>
</tbody>
</table>

**FullCodes**

*Figure 4-9. Coordinate File Format Including Code and Attribute*

• After importing this coordinate file to a job, the following information is displayed (Figure 4-10) for this point in the **CAD** tab:

![Figure 4-10. Point Properties - CAD tab](image)

If a custom format has mixed fullcodes, click both checkboxes (Figure 4-11).

![Figure 4-11. Mixed FullCodes](image)

3. If the file format contains FullCodes, it should be the last in the list of the right panel in the **Custom Format Properties** window.
4. Do not set the space delimiter for files containing codes with attributes. For this file, use the comma, tab, semicolon delimiters

**NOTICE**

*Topcon Link applies the default file name, UnName*.*, if no file name accompanies the new coordinate file format. In this case, Topcon Link deletes the new file format when closed.*
Opening a File Using Drag-and-drop

Topcon Link supports the drag-and-drop technique for opening files. Topcon Link can be either open or closed.

1. Run Windows Explorer on the computer.
2. Navigate to the location of the desired files, then select and highlight the files to open.
3. Drag-and-drop files or folders into either Topcon Link or onto the software shortcut. Dropping files onto the shortcut opens Topcon Link.

- When using the left mouse button, Topcon Link automatically detects the file type and format.
- When using the right mouse button, the *Drop options* dialog box displays from which to set the format and the type of selected files in the *Format name* drop-down list.

- Enable *Recurse folders* to open selected folders/subfolders and have Topcon Link open all files located in the folders/subfolders.
– For example: If *Recurse folders* is enabled after the folder “TS data” (Figure 4-14) was dragged-and-dropped, Topcon Link opens all the files located in the folders “coord file” and “raw data”.

![Figure 4-14. Selected Folder for Opening in Topcon Link](image)

**Viewing Files**

After opening a file, or transferring a file from an external device, a data table displays in the Topcon Link work area. The data table offers the following functionality:

- Sort column data in decreasing/increasing order.
  - Click on the column’s title (Figure 4-15)

![Figure 4-15. Sorting Data](image)

- Right-click the column’s title and click **Sort** from the pop-up menu (Figure 4-16)

![Figure 4-16. Sorting Data](image)
Maintaining Files

• Swap the order of data columns using the drag-and-drop technique (Figure 4-17). Click and hold on the column title, then “drag” to the new location and release.

![Figure 4-17. Swapping Data](before)

![Figure 4-17. Swapping Data](during)

![Figure 4-17. Swapping Data](after)

• Hide a column or reduce the size of a column by moving the right side of the column to the left side.

• Return a table to the initial state. For this, right-click a column’s title and click **Reset Columns**.

• Any table view changes are automatically saved for future use.

**Coordinate File Data Tables**

Coordinate Files display information on a *Point* tab in the data table (Figure 4-18).
The Points tab (Figure 4-18 on page 4-8) has the following default columns:

- Icon – the symbol of the point
- Name – the name of the point
- Latitude\Northing – the measured northing coordinate for the point and coordinate type
- Longitude\Easting – the measured easting coordinate for the point and coordinate type
- Elevation – the elevation of the point
- Note – any notes associated with the point
- Code – any codes associated with the point

Table 4-1 lists the symbols Topcon Link uses to represent different information in the data table.

<table>
<thead>
<tr>
<th>Location</th>
<th>Symbols</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point Tab</td>
<td>![Symbol]</td>
<td>Unknown point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Fixed coordinates point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Offset point (only for GTS-7 Points)</td>
</tr>
</tbody>
</table>

Every coordinate file (except the FC-5 format file) does not allow recording information about coordinate units and coordinate system. After opening a coordinate file, the Status Bar displays that the units are unknown and the coordinate system is undefined. Depending on the type of coordinates in the file, the following information will be displayed (Figure 4-19).

![Figure 4-19. Status Bar Information about Coordinate File]
Linear units and coordinate system can be changed. To do this, double-click on the appropriate box and select the desired unit or coordinate system (Figure 4-20).

When changing the units or the coordinate system, the coordinate values will not be transformed according to the specified unit. The selected units and coordinate system will be assigned to the coordinates left unchanged. Figure 4-21 displays the coordinate file displaying various setting of linear units and unchanged values of the coordinates.

To assign linear units and coordinate systems (Figure 4-22 on page 4-11) when opening a coordinate file, do the following:

1. Click **Advanced options** in the **Open** window.
2. Set the desired projection/datum, linear units, orthometric height and control.

![Figure 4-22. Parameters for Opened Coordinate File](image)

**Displaying Total Station Raw Data File Data Table**

The TS Obs tab displays only if the opened file contains TS raw data. Total Station (TS) raw data files display information in two tabs in the data table (Figure 4-23).

![Figure 4-23. Total Station Raw Data File](image)

The Points tab (Figure 4-23) has the following default columns for measured (not calculated) points:

- Icon – the symbol of the point
- Name – the name of the point
Maintaining Files

- Latitude\Northing – the measured northing coordinate for the point and the coordinate type
- Longitude\Easting – the measured easting coordinate for the point and the coordinate type
- Elevation – the elevation of the point
- Code – any codes associated with the point
- Control – the coordinate fix of the point (*None*, *Horizontal*, *Vertical*, *Both*)
- Note – any notes associated with the point

The *TS Obs* tab consists of two panels.

The left panel of the *TS Obs* tab (Figure 4-24) has the following default columns for points with known coordinates.

- Icon – the symbol of the point
- # – the number of the point
- Point Name – the name of the point
- Instrument Height – the height of the instrument in the selected units (ft, m)

![Figure 4-24. TS Obs Tab – Left Panel](image)

The right panel of the *TS Obs* tab (Figure 4-25 on page 4-13) has the following default columns for points with unknown coordinates measured from the point in the left panel.

- Icon – the symbol of the point
- # – the number of the point
- Point From – the beginning of the vector
- Point To – the end of the vector
- Reflector Height – the height of the reflector
• Azimuth, Horizontal Circle, Zenith Angle, Slope Distance – angular and linear measurements in the selected units (DMS, qon, mil, radian, ft, m)
• Note – any notes associated with the point
• Code – any code associated with the point
• Type – the type of point.
  – SS: side shot point
  – BS: backsight point (the previous occupation point)
  – FS: foresight point (the next occupation point)
  – BKB: backsight bearing point
  – Horizontal/Vertical Resection: plane or vertical coordinates of station point are computed using measurements from two (or more) points with known coordinates
  – Resection: plane and vertical coordinates of station point are computed using measurements from two (or more) points with known coordinates.

Figure 4-25. TS Obs Tab – Right Panel
Maintaining Files

Table 4-2 lists the symbols that represent different Topcon Link parameters in the data table.

<table>
<thead>
<tr>
<th>Location</th>
<th>Symbols</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Points Tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TS station</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TS point</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed coordinates point</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed Horizontal control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed Vertical control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TS Obs Tab, Left Panel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TS station</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TS Obs Tab, Right Panel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ForeSight measurement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SideShot measurement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BackSight</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TS Obs Tab, Right Panel (Continued)</td>
<td></td>
<td>BackSightBearing point measurement</td>
</tr>
<tr>
<td>TS Resection Observation</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

TS raw data file do not allow recording information about the coordinate system. After opening a TS raw data file, the Status Bar displays that the coordinate system is undefined (Figure 4-26).

Figure 4-26. Status Bar Information about TS Raw File
Only the linear/angular units and coordinate system can be changed for TS raw data files. To do this, double-click on the appropriate box and select the desired unit or coordinate system (Figure 4-27).

![Status Bar-> Linear Unit List and Coordinate System List](image1)

Figure 4-27. Status Bar-> Linear Unit List and Coordinate System List

When changing the units or the coordinate system, the linear and angular measurements will be transformed according to the specified unit, but the coordinate system will not be transformed. The coordinate system assigned to the coordinates are left unchanged. Figure 4-28 displays a TS Raw file with various projections and unchanged values of the coordinates.

![Example of changing projection for TS Raw Data File](image2)

Figure 4-28. Example of changing projection for TS Raw Data File

To assign a coordinate system when opening a TS raw data file (Figure 4-29), do the following:

1. Click **Advanced options** in the **Open** window.
2. Set the desired projection, coordinate order, and mode of vertical angle.

![Figure 4-29. Parameters for Opened TS Raw Data File](image)

**About Vertical Angles**

When measuring, you can select TS raw data file and save into the raw data file the vertical angle read from zenith (zenith mode) or from horizontal (level mode).

1. After opening a TS raw data file, the *TS Obs* tab displays the values of vertical angle in two different columns:
   - Zenith Angle – the vertical angle from Zenith.
   - Vertical Angle – the vertical angle from Horizontal. For the point, the sum of the Zenith Vertical Angles equals n*90.

2. TS raw data files do not allow recording information about vertical angle mode. However, you can set it when opening a TS raw data file: on the Vertical Angle field (Figure 4-30), set the mode which was enabled for the survey in the Total Station.

![Figure 4-30. Vertical Angle field in the Open Window for TS Raw Data File](image)

3. Select **Auto** if there is no information on the VA mode. In this case, the angles from 0 to 45 degrees are automatically considered as Horizontal, and the angles from 45 degrees and more as Zenith.
WARNING
When opening a TS raw data file containing vertical angles that exceeds 45 degrees, you must set the Vertical Angle mode the same as for measuring with the Total Station. If a different mode or Auto mode is set, then for these vertical angles, the Vertical Angle column will display the values read from zenith, and the Zenith Angle column will display the values read from the horizontal level.

Figure 4-31. A) Vertical Angle is from Horizontal Level
B) Vertical Angle is from Zenith
Displaying Digital Level Observation

The DL Obs tab displays only if the opened file contains data collected on Topcon’s Digital Level. Figure 4-32 shows an example of digital level data.

Click the DL Obs tab to view digital level information (Figure 4-33 on page 4-19).

The DL Obs tab displays a table containing two panels. The left panel displays the start and end level points of a job and the right panel displays all level measurements of the selected job.

The left panel of the DL Obs tab has the following columns.

- Icon – the symbol of the leveling job.
- # – the number of the leveling job.
- From – the start leveling point of the job.
- To – the finish leveling point of the job.
- Level Run – the name of the leveling job created in a Topcon digital level.
- Date – the start date (day/month/year) and time of job creation
- Note – displays user comments.
- Distance – the sum of all backsight and foresight distances.
- Balance – the sum of differences between DL to BS point and DL to FS point of the job.

The right panel of the DL Obs tab has the following columns.

- Icon – displays any image associated with turning points.
- # – the number of measurement.
• Point – the name of the turning point.
• BS – the measurement for backsight point.
• FS – the measurement for foresight point.
• Distance – measured distance.
• Elevation – the orthometric heights of the point (or the height of the point is calculated from a point with known height).
• Vert. Offset – displays the vertical offset from the horizontal plane for traverse and sideshot points.
• Note – any comment for the level measurement.
• Std Dev – standard deviation for the level measurement. This value is created in the Digital Level.
• Date – the date and time of level measurement.
• Level Run – the name of the leveling job created in a Topcon Digital Level

Figure 4-33. DL Obs Tab

Click on a column’s heading to sort DL Obs tab information in alphabetical order (note), descending/ascending order (#, point), or increasing/decreasing order (distance, balance, elevation).

**NOTICE**

Any entered changes cannot be saved in the file.
Table 4-3 lists the symbols that represent different Topcon Link parameters in the data table.

<table>
<thead>
<tr>
<th>Location</th>
<th>Symbols</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Points Tab</td>
<td>![Symbol]</td>
<td>Traverse Point for digital level observation</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Side Shot</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Fixed coordinates point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Fixed Horizontal control</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Fixed Vertical control</td>
</tr>
<tr>
<td>DL Obs Tab, Left Panel</td>
<td>![Symbol]</td>
<td>Leveling job</td>
</tr>
<tr>
<td>DL Obs Tab, Right Panel</td>
<td>![Symbol]</td>
<td>BackSight level measurement</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>ForeSight level measurement</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>SideShot level measurement</td>
</tr>
</tbody>
</table>
TopSURV File Data Table

TopSURV database files display information in the following tabs (Figure 4-34).

The Points tab (Figure 4-34) has the following default columns.

- **Icon** – the symbol of the point.
- **Name** – the name of the point.
- **Latitude\Northing** – the measured northing coordinate for the point and the coordinate type.
- **Longitude\Easting** – the measured easting coordinate for the point and the coordinate type.
- **Elevation** – the elevation of the point.
- **Code** – any codes associated with the point.
- **Control** – the coordinate fix of the point (None, Horizontal, Vertical, Both).
- **Note** – any notes associated with the point.
NOTICE

If a geoid was used to calculate orthometric heights for the points in the TopSURV file, and this geoid model was not pre-defined in Topcon Link, the point heights will be calculated incorrectly when opening the file. In this case the following warning will be displayed (Figure 4-35).

![Figure 4-35. Warning-Geoid Model is not in the List](image)

To calculate the orthometric heights in Topcon Link, it is necessary to add the geoid model. For details on adding geoid models, see page 5-17.

The GPS Occupations tab displays only when an opened file contains GPS data. The GPS Occupations tab displays a table that can contain the following informational columns (Figure 4-36 on page 4-23).

- Icon – displays a symbol associated with the occupation.
- Point Name – displays the name of the occupation.
- Original Name – displays the original occupation name.
- Antenna Type – the antenna type used on the occupation.
- Antenna Height – the antenna height.
- Antenna Height Method – the method used to measure the antenna height, either Vertical or Slant.
- Start Time and Stop Time – displays the beginning and end dates (day/month/year) and starting and stopping epoch time of the occupation.
- Duration – the duration of time in which the observational data was acquired (duration = start time - stop time).
- Method – the surveying method used at the occupation; either Static or Kinematic.
- Note – displays user comments.
- Source – displays the path of the source information on the computer disk drive, local area network, or storage media.
- Interval – displays the occupation logging interval.
- Receiver – displays the TPS receiver serial number used for the occupation.
- Offset Azimuth – defines the direction from occupation other horizontal offsets (distance and cross) are given.
- Offset Dist – displays the occupation’s distance offset.
- Offset dHt – displays the occupation’s height offset.
- Offset Across – displays the occupation’s across offset.

**NOTICE**

Any changes entered cannot be saved in the file.

The **TS Obs** tab displays only when the file contains TS raw data file and consists of two panels.

The left panel of the **TS Obs** tab (Figure 4-37 on page 4-24) has the following default columns for points with known coordinates.

- Icon – the symbol of the point.
- # – the number of the point.
- Point Name – the name of the point.
- Instrument Height – the height of the instrument in the selected units (ft, m).

The right panel of the **TS Obs** tab (Figure 4-37 on page 4-24) has the following default columns for points with unknown coordinates measured from the point in the left panel.

- Icon – the symbol of the point.
- # – point number.
• Point From – the beginning of the vector.
• Point To – the end of the vector.
• Reflector Height – the height of the reflector.
• Azimuth, Horizontal Circle, Zenith Angle, Slope Distance – angular and linear measurements in the selected unit (DMS, qon, mil, radian, ft, m).
• Code – any code associated with the point.
• Type – the type of point (SS, BS, FS, Horizontal/Vertical Resection, Resection, BKB).
• Note – any notes associated with the point.
• Date – date and time of the point measurement.

The GPS Obs tab displays only when the file contains GPS data. The GPS Obs tab (Figure 4-38 on page 4-25) has the following default columns for baseline measurements from the Base station to the Rover point:

• Icon – the symbol of the point.
• Point From – the starting point of the baseline measurement.
• Point To – the ending point of the baseline measurement.
• Start Time – the date and time of the start of the measurement.
• Duration – the time during which the measurement was taken.
• Note – any note for the baseline measurement.
• Horizontal Precisions, Vertical Precisions – displays horizontal and vertical precisions of the measurement.
• dN, dE, dU – displays coordinate increments of the measurement in the current projection.
• Method – displays the measurement method (RTK Topo or RTK AutoTopo).
• Solution type – displays the type of solution used for the measurement.
  – **Float, Phase Diff**: float phase difference measurement
  – **FixeMd, Phase Diff**: fixed phase difference measurement
  – **Float, Phase Diff, mm GPS**: float phase difference measurement with mm GPS
  – **Fixed, Phase Diff, mm GPS**: fixed phase difference measurement with mm GPS

Figure 4-38. GPS Obs Tab
To view the information about an observation (vector), right-click the vector on the GPS Obs tab and click Properties on the pop-up menu. On the Properties dialog box, click the Observation tab (Figure 4-39).

Figure 4-39. GPS Obs Properties – Observation Tab
The *Codes* tab displays only when the file contains a code(s) and consists of two panels.

The left panel of the *Codes* tab (Figure 4-40) lists available (*.tslv) file codes and has the following columns:

- **Icon** – the symbol of the object
- **Code** – the code of the object
- **Layer** – display the layer in which the code is used

The right panel displays all possible attributes for the object highlighted in the left panel of the *Codes* tab (Figure 4-40 on page 4-26) has the following columns:

- **Icon** – the symbol of the attribute
- **Name** – a unique name for the attribute
- **Default value** – the value of the attribute
- **Type** – the type of attribute (integer, real number, text, or menu)

![Figure 4-40. Codes Tab](image)

The *Linework* tab displays only when the file contains a linework file, and displays CAD information contained in the open file (Figure 4-41 on page 4-27).

The *Linework* tab displays a table containing two panels. The left panel displays all lines (codes, layers and strings) in the job and the right panel displays all line segments for the selected line. The *Linework* tab can have the following informational columns:

- **Icon** – displays the symbol associated with the line or line segment.
- **Code** – displays the primary code used for the line or line segment.
- **Layer** – displays the layer for the selected line.
• Color/Line Style/ Point Symbol/Line Width – displays the plotting style of the selected line.
• Order – lists the order of points associated with the line segment.
• From – lists the beginning point of the line segment.
• To – lists the end point of the line segment. If the line is closed, the “To” point for the last segment will be the same as the start point of the line.
• Control Code – displays the control code of the point.
  – Arc Start: the starting point of the arc
  – Arc End: the ending point of the arc
  – Close: the last point in a closed line

To view the String (in left panel) and Control Code (in right panel) columns, enable the alphanumeric code output for describing surveyed points during job configuration.

Figure 4-41. Linework Tab
The *Tape Dimensions* tab displays only when the file contains a tape dimension measurement. The *Tape Dimensions* tab displays the results of measurements of lines perpendicular to a reference line. The reference line is defined using two points with known coordinates. Figure 4-42 shows an example of measurements relative to the reference line 1-2, performed in Tape Dimensions mode.

The *Tape Dimensions* tab consists of two panels.

- The left panel of the *Tape Dimensions* tab (Figure 4-43 on page 4-29) shows the symbol of the start reference line, the names of the start and end points of this line.
- The right panel of the *Tape Dimensions* tab (Figure 4-43 on page 4-29) has the following default columns for tape measurements from the End point to the Start point:
  - Icon: the symbol of the point
  - #: measurement sessions
  - Point to: measurement direction
  - Distance: the length of the line. The “-” sign stands for the left turn, and the “+” sign stands for the right turn relative to the direction of the measurement the last line.
  - Date: the date and time of the measurement finished
  - Note: any notes associated with the measurement
The *Images* tab displays only when the file contains data associated with captured images, such as data obtained with the GPT-7000i total station.

The data file and the image folder must reside in the same directory for the images to display correctly in Topcon Link.

**NOTICE**

Topcon Link expects the associated images to reside in a folder with the same name as the data file. For example, data from the "050119.tlsv" file will be associated with images in the "050119" folder.

The *Images* tab displays the following two panels.

- The left panel displays thumbnail images for all images in the file. Image identification in the panel begins with the lowest image title (either alphabetically or numerically) and increases incrementally.
- The right panel displays the selected image with measured points and linework inside the picture area. The symbols of the points correspond to the settings selected in the *Line and Code properties* dialog boxes. The size of the symbol depends on the distance from the station.
Click a thumbnail in the left panel (Figure 4-44) to view the image in the right panel.

![Figure 4-44. Images Tab](image)

The *X-Section Templates* tab displays only if the job contains road data. Click the *X-Section Templates* tab to view the information about existing templates in the opened file (Figure 4-45 on page 4-31).

- The left panel of the *X-Section Templates* tab displays the name of the template(s) and values of the cut and fill slopes in percent. The right panel displays the segment(s) of the selected template in table and graphic mode.

- The right panel of the *X-Section Templates* tab has the following default columns for segments used in the selected template:
  - Icon: the symbol of the segment.
  - Order the order of the template segment.
  - Code: the code used for the segment.
  - Hz. Dist: the horizontal offset from the central line for the segment.
  - V.Dist: the vertical offset from the horizontal plane for the segment. If this parameter is selected, the Grade will be automatically calculated.
  - Grade%: the ratio of Hz. Dist and V.Dist multiplied by 100%. If this parameter is selected, the V.Dist will be automatically calculated.
- Hz. Offset from CL (m): horizontal offset from the central line for the segment start point. Calculated using the corresponding values of previous the segment(s) and is not editable.
- V. offset from CL (m): vertical offset from the horizontal plane for the start point of the segment. Calculated using the corresponding values of previous the segment(s) and is not editable.

The Roads tab displays only if the file contains road data. Click the Roads tab to view the information about existing roads in the current job (Figure 4-46).

The left panel of the Roads tab displays the names of the roads, the middle panel displays horizontal/vertical alignments and x-section of the selected road in a table, and the right panel displays a 2D graphic of the selected alignment/x-section.
The *Horizontal alignment* table shows the list of horizontal alignment elements, the horizontal alignment plot, and the starting station of each element. The horizontal elements table can contain the following informational column:

- **Icon** – displays an image associated with the elements.
  - : Line
  - : Spiral
  - : Curve
  - : Intersection

- **Order** – the order of the element in the horizontal alignment.
- **Type** – the type of element (line, curve, spiral, or intersection).
- **Azimuth** – the azimuth of the element.
- **Length** – the length of the element; editable for all types of elements except Intersection, where the length is calculated for the compound curve consisting of two spirals and one curve.
- **Turn** – the direction of the turn for a curve, a spiral, and intersection. The “Right” value stands for clockwise direction; the “Left” value stands for counter-clockwise direction.
- **Start Radius/End Radius** – the radius of the curve or spiral.
- **Nothing /Easting** – the grid/ground coordinates of the intersection point.
- **Spiral 1 Len/Spiral 2 Len** – the length of the spiral at the intersection point.
- **End Station** – the number of the end station for the element.
- **Intersection Pt** – the name of the intersection point.
- **Tangential to prev element** – displays “True” or “False”. True is set if the azimuth for this element is the end azimuth for the previous element; False is set if the azimuth for this element is arbitrary.
- **End Northing /End Easting** – the grid/ground coordinates of the end station of the element.
- End Azimuth – the azimuth that sets the tangent to the end station of the element.
- Spiral Dir – the spiral direction.
- Delta – the angle between the radii corresponding to the curve.
- Chord – the length of the segment joining start and end points of a curve.
- Tangent – the length of the segment which touches the given curve.
- Mid Ord – the distance from the midpoint of a chord to the midpoint of the corresponding curve.
- External – the distance from the midpoint of the curve to the intersection point of the tangents.
- Spiral Const – the square root of the product of the length and the radius of the spiral.
- Spiral Const 1/Spiral Const 2 – the spiral constants used to define a compound curve.
- Start Deg Chord/End Deg Curve – the angle in degrees used to compute the radius of curve whose chord is 100 units long.

The Vertical alignment table shows a list of the vertical alignment elements, the vertical alignment plot and the starting station of each element. The vertical elements table can contain the following columns.

- Icon – displays an image associated with the elements.
  - : Grade
  - : Long Section
  - : Parabola
- Type – the type of the element (grade, parabola, or long section).
- Sta/Chainage – the number of the start station or chainage for the grade, parabola, and long section element.
- Order – the order of the element in the vertical alignment.
- Length – the length of the vertical element for the grade and parabola, and the length of the curve of the long section.
• Start Grade / End Grade – the starting and ending percentages of grade of the element. If the grade is rising, the value should be set to positive; if the grade is falling, the value should be set to negative.

• Elevation – the elevation value on the end station for the grade and parabola and the elevation value of the station used for creating of the long section.

The X-Section tab contains a list of stations where cross section templates are applied, and displays a general view of the cross section.

• Station – the station at which the template is applied.
• Side – the left or the right side of the road relative to the central line where this template is used
• Template – the name of the template (selected from the list of existing templates in the current job).
Table 4-4 lists the symbols that represent different Topcon Link parameters on the data table.

**Table 4-4. TopSURV File Symbols**

<table>
<thead>
<tr>
<th>Location</th>
<th>Symbols</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Points Tab</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>TS station</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>TS point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>TS BackSight point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Point coordinates input manually</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Point coordinates calculated by means of COGO</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Design point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Stakeout point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Fixed coordinates point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Fixed Horizontal control</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Fixed Vertical control</td>
</tr>
<tr>
<td><strong>Points Tab</strong> (Continued)</td>
<td>![Symbol]</td>
<td>Base station</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Topo point&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Auto Topo point&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>PTL (point to line) offset point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>GPS offset point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Tape Measurement Point</td>
</tr>
<tr>
<td><strong>TS Obs Tab, Left Panel</strong></td>
<td>![Symbol]</td>
<td>TS station</td>
</tr>
</tbody>
</table>
Table 4-4. TopSURV File Symbols (Continued)

<table>
<thead>
<tr>
<th>Location</th>
<th>Symbols</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TS Obs Tab, Right Panel</td>
<td>![Symbol]</td>
<td>ForeSight measurement</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>SideShot measurement</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>BackSight measurement</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>BackSightBearing point measurement</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>TS Resection Observation</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>TS MLM Observation</td>
</tr>
<tr>
<td>GPS Occupation Tab</td>
<td>![Symbol]</td>
<td>Base station occupation</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Auto Topo occupation&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Topo occupation&lt;sup&gt;d&lt;/sup&gt;</td>
</tr>
<tr>
<td>GPS Obs Tab</td>
<td>![Symbol]</td>
<td>Baseline from the base station to a Topo point</td>
</tr>
<tr>
<td></td>
<td>![Symbol]</td>
<td>Baseline from the base station to an Auto Topo point</td>
</tr>
<tr>
<td>Tape Dimensions Tab Left Panel</td>
<td>![Symbol]</td>
<td>Start reference line</td>
</tr>
<tr>
<td>Tape Dimensions Tab Right Panel</td>
<td>![Symbol]</td>
<td>Tape Measurement Point</td>
</tr>
</tbody>
</table>

---

a. Topo point – the point collected during a static RTK measurement  
b. Auto Topo point – the point collected during a kinematic RTK measurement  
c. Auto Topo occupation – the kinematic occupation in the RTK survey  
d. Topo occupation – the static occupation in the RTK survey
Every TopSURV database file allows recording information about the linear and angular units, the coordinate type, and the coordinate system. After opening a TopSURV file, the Status Bar displays the following information from this file (Figure 4-47).

You can change any units, coordinate type, and coordinate system. To do this, double-click on the appropriate box and select the desired unit or coordinate system (Figure 4-47).

When changing the units or the coordinate type and coordinate system, the file parameters will be transformed.

**CAD View**

1. Use the CAD View to view graphic information in an open TopSurv file. To open CAD View for the TopSURV file, open the Topsurf file and click ViewCAD View.

2. The CAD view is a graphical view (Figure 4-48 on page 4-38) of linework roads and surfaces with the associated points. Unless filtered, the following information displays:
   - Points and their symbols display on the CAD view. If the point does not have a symbol, its survey symbol will be used.
   - Lines display using the code’s/layer’s color, style, and width.
   - If a line contains valid /AS, /AE, /C control codes, it will display as an arc or closed polyline, respectively.
   - If a code includes a polygon entity type, it will display as closed and filled (if a fill color has been set).
   - Surfaces and roads are displayed in the color applied to the corresponding layer(s).
Displaying CAD View Options

View options for the CAD View include displaying a coordinate grid and selecting labels to display for points.

1. Right-click on an empty portion of the CAD view and click **Options** on the pop-up menu.
2. To show grid, select the **Show** tab, and click the **Show grid box** (Figure 4-49 on page 4-39).
3. On the **Labels** tab, enable the desired settings. Click **Apply** to save the settings (Figure 4-49 on page 4-39).
   - Name – enable to display the point’s name on selected map, the cursor, and status bar positions.
   - Code – enable to display the point’s code on selected map, the cursor, and status bar positions.
   - Height – enable to display the point’s height on selected map, the cursor, and status bar positions.
4. Click **OK** to save the settings and close the **Cad View Options** dialog box.
Viewing File Properties

To view an open file’s properties, click **File ➤ File properties** (Figure 4-50).

- Coordinate files – displays the path to the opened file and the file format (Figure 4-51).
Maintaining Files

- TopSURV files – displays the file name, path to the opened file, file format, job name and surveyor’s name (Figure 4-52).

![Figure 4-52. Properties for TopSURV File](image)

- Total Station raw data files
  - displays the name and format data in the General tab (Figure 4-53)
  - displays the date and end time of survey, instrument, job, survey’s name, and note in the Session tab

![Figure 4-53. Properties for TS Raw Data File](image)
Editing Files

You can edit, save, and convert files opened in Topcon Link to a corresponding file format.

Saving Files

When saving the edited file (*.*) for the first time, Topcon Link makes a copy of the initial file (*.*.initial) in the current folder before saving. This file is left unchanged. All changes will be saved in the *. file.

To save changes to the current file, click File > Save File.

To save a file with another name:
1. Click File > Save As.
2. Select or create a destination folder and enter a new name in the Save As dialog box.
3. Click Save.

Converting Opened Files to Other File Formats

A currently open file can be converted to a corresponding file format using the Save As dialog box.

Note: See page 3-2 for the list of file formats that Topcon Link can convert.

1. Click File > Save As.
2. Select or create a destination folder and enter a name for the new file in the Save As dialog box.
3. Select a file format for the new file.
4. Click Advanced options to display further conversion parameters. Enter the desired information.

The characteristics of file conversion will be described in detail in further sections about editing coordinate files, TS raw data files and TopSURV files.
Editing Coordinate Files

Topcon Link saves a coordinate file with possibility of transforming coordinates into different coordinate system and units. A coordinate file can be converted into another coordinate file and the format of TopSURV file.

To convert one file to another file, do the following:

1. Click **File > Save As**.
2. Select or create a destination folder and enter a name for the created file in the **Save As** dialog box.
3. Select ‘Coordinate File’ or ‘TopSURV Database File’ format for the created file.
4. Click **Advanced options** to display further conversion parameters. Enter the desired information.
5. When saving a file as a coordinate file, it is possible to set the desired projection/datum, linear units, and to select or add a geoid file (Figure 4-54).

![Figure 4-54. Parameters for Created Coordinate File](image)

6. When saving a file as a TopSURV file, you can set the desired projection/datum, linear and angular units, coordinate type and coordinate order, and select or add a geoid file (Figure 4-55 on page 4-43).
7. Click **Save**.

The difference between the created TopSURV file and the coordinate file is that the Status Bar for a TopSURV file displays linear and angle units, coordinate type, and coordinate system. For a coordinate file, these values are undefined in the Status Bar. Coordinate values are the same for both files (Figure 4-56).

**Figure 4-55. Parameters for Created TopSURV File**

**Figure 4-56. Examples of Created TopSURV and Coordinate Files**

In coordinate files, the following parameters can be edited.

- Point name
- Code
- Point coordinate
- Coordinate point order
- Note
- Offsets for GTS-7 Point file format
8. To edit coordinate file information, right-click one of the point rows to display the coordinate file pop-up menu (Figure 4-57).

![Figure 4-57. Coordinate File Pop-up Menu](image)

- Cut – cuts the information.
- Copy – copies the information.
- Delete – deletes the information.
- Properties – displays the Properties dialog box.
- Options – opens the Option window (Figure 4-58) where you can change the columns order or hide any column.

![Figure 4-58. Options Window For Points Tab](image)

**Edit Name and Note Properties**

To edit the point name and note in a coordinate file:

1. Right-click a point and click Properties on the pop-up menu.
2. On the Properties dialog box, click the General tab (Figure 4-59 on page 4-45).
3. Edit the Name and Note fields as needed.
4. Click OK to set the changes and close the dialog box. Click Apply to set the changes and continue editing the point.
Edit Coordinate Properties

To edit the point coordinates in a coordinate file:

1. Right-click the point and click Properties on the pop-up menu.
2. On the Properties dialog box, click the Coordinates tab (Figure 4-60).

3. Depending on the type of the coordinate file, edit the Ground Northing/Grid Northing, Ground Easting/Grid Easting, and Elevation fields as needed.

4. Click OK to set the changes and close the dialog box. Click Apply to set the changes and continue editing the point.
Edit CAD Properties

To edit CAD properties of a point in a coordinate file:

1. Right-click the point and click **Properties** on the pop-up menu.
2. On the **Properties** dialog box, click the **CAD** tab (Figure 4-61).

![Figure 4-61. Point Properties – CAD Tab](image)

3. Select or edit the **Codes** as needed.
4. Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.

**NOTICE**

For coordinate files, only one code can be created per point. But if a coordinate file is created by converting from TopSURV file to custom coordinate file format with fullcode option, this coordinate file can contain an unlimited number of codes for a point.

Edit Offset Properties

Topcon Link allows editing/adding offsets for TS measuring with using point to line (PTL) method. For details on this, see “Offset Point to Line” on page A-3. To edit offset properties for a point in a GTS-7 Point file:

1. Right-click the point and click **Properties** on the pop-up menu.
2. On the **Properties** dialog box, click the **Offset** tab (Figure 4-62 on page 4-47).
3. Edit the **Offset** fields as needed.
4. Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.

![Image of Point Properties – Offset Tab](image)

**Figure 4-62. Point Properties – Offset Tab**

5. After editing offset values, to obtain new coordinates of the point, click the **Compute Coordinates** button on the toolbar to recalculate coordinates.

**Saving Note and Code Changes in Coordinate Files to a Different Coordinate File**

**NOTICE**

*Topcon Link cannot save edited information if the file currently lacks the information fields. If Note or Code information is changed for GTS-210/310-10, GTS-210/310-12, FC-5 format files or user-defined format files without Note or Code columns, Topcon Link will display the following dialog box (Figure 4-63).*

![Image of Save to Another Format? dialog box](image)

**Figure 4-63. Save to Another Format?**

Click **No** or **Cancel** to continue without saving.

1. To save the file to a different format, click **Yes**.
2. On the *Save as* dialog box, select a user-defined format in the *Format File* field that includes Note and Code columns (Figure 4-64). See “Creating User-defined File Formats” on page 4-2 for more information.

![Figure 4-64. Format Name](image)

3. Enter the name and location of the new file.

4. Click *Save*.

**Editing Total Station Raw Data Files**

Topcon Link allows saving TS raw data file through transforming linear units, angular units and coordinates into a different coordinate system. A TS raw data file can be converted into another TS raw data file and into a TopSURV file format.

To convert a file to another file type, do the following:

1. Click **File ▶ Save As** or click the **Save as** button on the Toolbar.
2. Select or create a destination folder and enter a name of the created file in the *Save As* dialog box.
4. Click **Advanced options** in the *Save As* window.
5. When saving a file as a TS raw data file, it is possible to set the desired projection, linear units, angular units, coordinate type and coordinate order, mode of vertical angle, and type of distance (Figure 4-65 on page 4-49).
6. Using the settings in the *Vertical Angle* and *Distance is* fields, these measurements can be converted and saved in the file.

7. In Total Station (TS) raw data files (Figure 4-66 on page 4-50), the following information can be edited.

- In the *Point* tab:
  - Point name
  - Point coordinate
  - Control

- In the left panel of the *TS Obs* tab:
  - Point name and point number
  - Instrument height

- In the right panel of the *TS Obs* tab:
  - Point to and point notes
  - Reflector height
  - Azimuth (only for BKB points measured from the point with unknown coordinates)
  - Offsets
  - CAD information
  - String properties
  - Type of measured point (except BKB points)
To edit TS raw data file information in the left or right panels, right-click a point row to display the pop-up menu.

- Cut – cuts the information
- Copy – copies the information
- Delete – deletes the information
- Properties – displays the Properties dialog box
- Options - displays the Option window

**TIP**
Click a column’s heading to sort data in descending or ascending order.

### Editing Name, Instrument Height, and Number Properties

Do the following to edit name, instrument height, and number properties of a point in a TS raw data file:

1. Right-click the point in the left panel and click Properties on the pop-up menu.
2. On the Properties dialog box, edit point name, instrument height and point number as needed (Figure 4-67).
3. Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.

**Editing Point To, Notes and Codes Properties**

Do the following to edit the point to, note, and codes of a point in a TS raw data file:

1. Right-click the point in the right panel and click **Properties** on the pop-up menu.
2. On the **Properties** dialog box, click the **General** tab (Figure 4-68).
3. Edit the **Point To**, **Note**, and **Code** fields as needed.
4. Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.

![Figure 4-68. TS Properties – General Tab](image)

**Editing Reflector Height and Azimuth Properties**

In TS raw data files, edit the reflector height for any point and azimuth for BKB points measured from the point in the following cases.

- the coordinates are unknown coordinates.
- the point’s coordinates can not be calculated.

1. Right-click the point in the right panel and click **Properties** on the pop-up menu.
2. On the **Properties** dialog box, click the **Observation** tab (Figure 4-69).

![Figure 4-69. TS Properties – Observation Tab](image)

3. Edit the **Reflector Height** and **Azimuth** fields as needed.
4. Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.

**Editing Offset Properties**

Topcon Link allows editing/adding offsets for TS measurements using the “from observation line” method. For details on this, see “Offsets From an Observation Line” on page A-2.

To edit the offset property of a point in a TS raw data file:

1. Right-click the point in the right panel and click **Properties** on the pop-up menu.
2. On the **Properties** dialog box, click the **Offset** tab (Figure 4-70).

![Figure 4-70. TS Properties – Offset Tab](image)
3. Edit the Offset fields as needed.

4. Click OK to set the changes and close the dialog box. Click Apply to set the changes and continue editing the point.

5. After editing offset values, to obtain new coordinates of the point, click Calculate Coordinates on the toolbar to recalculate coordinates.

**Editing String Properties**

To edit the string property of a point in a TS raw data file (only available when Display String and Control Code is enabled; see “Editing Point Code Description” on page 4-55) do the following:

1. Right-click the point in the right panel and click Properties on the pop-up menu.

2. On the Properties dialog box, click the String tab (Figure 4-71 on page 4-53). If the point code has been specified in the Code field, the fields String and Control Code will be enabled for editing.

3. Edit String and Control Code fields as needed.

4. Click OK to set the changes and close the dialog box. Click Apply to set the changes and continue editing the point.
Editing TS Observation Display Properties

To change the columns order or hide any column in TS Obs tab:

1. Right-click the point in the right or left panel and click **Options** on the pop-up menu.

2. On the **Options** window (Figure 4-72) select the desired entry (icon, point from, point to, reflector height, etc.), then:
   - Use the right arrow button to move entries from the left field to the right field. The order of names in the right field must correspond to the order of names in the opened TS raw file.
   - Use the left arrow button to move entries out of the right panel and back to the left panel.
   - Use the Move Up and Move Down buttons to move names in the right panel up and down.

3. Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.

![Figure 4-72. Options Window For TS Obs Tab](image)
Editing Files

Editing Point Code Description

To edit the letter/numerical code for point description in a TS raw data file:

1. Click File ➤ Configuration.
2. On the Configuration dialog box, click Display and then the Strings tab (Figure 4-73).

![Figure 4-73. Configuration – Strings Tab](image)

3. Click the Display String and Control Code option. String and Control Code columns will be added to the right panel of the TS Obs tab. CAD and String tabs will be added to the Properties dialog box.
4. Click OK.

Editing the Type of Point

To edit the type of measured point, double click in the Type column of the point and select a type from the drop-down list (Figure 4-74).

![Figure 4-74. Edit Type of Measured Point](image)
Editing Multiple Points

To edit the instrument height, reflector height, comment, point name, or measurements for multiple points in either panel,

1. Press the Shift key and click several rows (Figure 4-75).
2. Enter the new information to any selected row (Figure 4-75).
3. Press Enter to apply the edited data to all the selected rows.

<table>
<thead>
<tr>
<th>#</th>
<th>From</th>
<th>To</th>
<th>Reflect Height (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>STZ-2</td>
<td>9</td>
<td>1.50000</td>
</tr>
<tr>
<td>22</td>
<td>STZ-2</td>
<td>10</td>
<td>1.60000</td>
</tr>
<tr>
<td>23</td>
<td>STZ-2</td>
<td>11</td>
<td>1.60000</td>
</tr>
<tr>
<td>24</td>
<td>STZ-2</td>
<td>12</td>
<td>1.50000</td>
</tr>
<tr>
<td>25</td>
<td>STZ-2</td>
<td>13</td>
<td>1.50000</td>
</tr>
<tr>
<td>26</td>
<td>STZ-2</td>
<td>14</td>
<td>1.50000</td>
</tr>
<tr>
<td>27</td>
<td>STZ-2</td>
<td>15</td>
<td>1.50000</td>
</tr>
</tbody>
</table>

Figure 4-75. Select and Edit Multiple Rows of Data

Editing TopSURV Files

In TopSURV files (Figure 4-76 on page 4-57), the following information can be edited.

- Point parameters (in Point tab).
  - Name, point coordinates, note, control and codes string and control code and offsets offset point
- GPS occupations parameters (in GPS Occupation tab):
  - Name, antenna type and height, and method of height measurement, offsets
- TS observation parameters (in TS Obs tab).
  - Point name and point number, instrument height
  - Point to and point notes, reflector height, azimuth (only for BKB points measured from the point with unknown coordinates), offsets, CAD information, string properties
- GPS observation parameters (in GPS Obs tab).
  - Vector notes
• Road parameters (in Roads tab).
  – Road name, start station/chainage, layer
  – Delete any alignment and x-section

• X-Section Templates parameters (in the X-Section Templates tab).
  – X-section templates name
  – Delete any segment used for creating the template

• Linework parameters (in the Linework tab).
  – Plotting style of the line
  – Delete any line segments for the selected line
  – Change the control code

![Figure 4-76. Sample TopSURV File](image)

To edit TopSURV file information in any tabs, right-click a point or row to display the a pop-up menu.

• Cut – cuts the information
• Copy – copies the information
• Delete – deletes the information
• Properties – displays the properties dialog box
• Options – displays Options window
Editing Point Name and Note Properties

Coordinates of any points contained in the TopSURV file display in the Point tab.

1. To edit point name, notes and codes, right-click the point and click Properties on the pop-up menu.
2. On the Properties dialog box, click the General tab (Figure 4-77).

![Figure 4-77. Point Properties – General Tab](image)

3. Edit the Name, Note, Code, and Control fields as needed.
4. Click OK to set the changes and close the dialog box. Click Apply to set the changes and continue editing the point.

Editing Point Coordinates

1. Click the Point tab.
2. To edit point coordinates, right-click the point and click Properties on the pop-up menu.
3. On the Properties dialog box, click the Coordinates tab (Figure 4-78 on page 4-59).
4. Depending on the type of coordinate file, edit the Ground Northing/Grid Northing/Latitude, Ground Easting/Grid Easting/Longitude, and Elevation/Ell. Height fields as needed.
5. Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.

![Figure 4-78. Point Properties – Coordinates Tab](image)

**Adding a New Point Code**

1. Click the **Point** tab.
2. To add a new point code, right-click the point and click **Properties** on the pop-up menu. On the **Properties** dialog box, click the **CAD** tab.
3. Right-click in the **Name** field and click **New Code** on the pop-up menu (Figure 4-79).

![Figure 4-79. Code Pop-up Menu in Point Tab](image)

4. Type the new code **Name** or select from the **Code** drop-down list and press **Enter**.
5. After entering a code for the point, the string parameters for this point can be entered.

   Note: Code attributes can be added/edited only in the **Codes** Tab.
6. Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.

**NOTICE**

*In TopSURV files, a point can have more than one code.*

**Editing Offset Properties**

In TopSURV files, Topcon Link allows editing/adding offsets with using point to line (PTL) method and offsets from the line with known azimuth. For details on this, see “Offset Point to Line” on page A-3.

To edit offset properties for a point in TopSURV file:

1. Click the **Point** tab.
2. Right-click the point and click **Properties** on the pop-up menu.
3. On the **Properties** dialog box, click the **Offset** tab (Figure 4-80).
4. Depending on the offset type, edit the offset fields as needed.
5. Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.
6. After editing offset values, to obtain new coordinates of the point, click **Calculate Coordinates** on the toolbar to recalculate coordinates.
Editing GPS Occupation Point Name

1. Click the *GPS Occupations* tab.
2. To edit the names of base and topo points, right-click the point and click *Properties* on the pop-up menu.
3. On the *Properties* dialog box, click the *General* tab (Figure 4-81).

   Edit the *Point Name* for the base and *topo points* field as needed.

![Figure 4-81. GPS Occupations Properties – General Tab](image-url)

4. Click *OK* to set the changes and close the dialog box. Click *Apply* to set the changes and continue editing the point.

Editing GPS Occupation Antenna Parameters

1. Click the *GPS Occupations* tab.
2. To edit the antenna parameters, right-click the point and click *Properties* on the pop-up menu.
3. On the *Properties* dialog box, click the *Antenna* tab (Figure 4-82 on page 4-62).

   Edit the antenna *Type*, *Height*, and *Method* fields as needed.
4. Click *OK* to set the changes and close the dialog box. Click *Apply* to set the changes and continue editing the point.
**WARNING**

If the base station has an “Unknown” antenna type, Topcon Link will not recalculate the coordinates of the points after editing base station coordinates or antenna height. To recalculate the coordinates of the points, specify the antenna type for the base station.

![Figure 4-82. GPS Occupation Properties – Antenna Tab](image)

**Adding Antennas Using the Custom Antenna List**

Each antenna type has unique phase center parameters obtained through calibration and stored in an ANTENNA.XML file.

These parameters are not viewable or editable. However, the **Custom Antennas List** adds user-defined antenna types to the antenna list, as well as displays, edits, and removes antennas from the antenna list.

1. To add a new antenna type to the antenna list or to edit an existing antenna type, click **Custom** in the **Properties** dialog box for a GPS Occupation (Figure 4-82).
2. To remove an antenna, click on the antenna’s row and click **Remove** (Figure 4-83 on page 4-63). Click **Add** to display the **New Custom Antenna** dialog box.
3. On the General tab, edit the NGS Name, Name, Manufacturer, and Note fields (Figure 4-84). Then click Apply to save the information.

4. Click the Parameters tab and enter the radius of antenna, offsets of the phase center from the antenna reference point (ARP) for L1 and L2 frequencies, and height measuring method for the antenna (Figure 4-84).

Figure 4-83. Custom Antenna List

Figure 4-84. New Custom Antenna – General and Parameters Tabs

Figure 4-85 shows how Topcon Link interprets antenna parameters.

Figure 4-85. Antenna Parameters
5. Click OK on the Properties dialog box.
6. To edit the parameters of an existing antenna right-click the antenna and click Properties on the pop-up menu. You can edit any parameters in the General and Parameters tabs.

**Edit GPS Occupation Offsets**

Topcon Link allows editing/adding offsets for GPS measurements with using the “offsets from the line with known azimuth” method. For details on this, see “Offsets From a Line with Known Azimuth” on page A-5.

1. Click the GPS Occupations tab.
2. To edit point offsets, right-click the point and click Properties on the pop-up menu.
3. On the Properties dialog box, click the Offset tab (Figure 4-86).

![Figure 4-86. GPS Occupation Properties – Offset Tab](image)

4. Edit the Offset fields as needed.
5. Click OK to set the changes and close the dialog box. Click Apply to set the changes and continue editing the point.
Editing GPS Occupations Display Properties

To change the column order or hide any column in *GPS Occupation* tab, use the **Options** dialog box (Figure 4-87).

![Figure 4-87. Options Window For GPS Occupation Tab](image)

Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.

**Editing TS Obs Parameters**

1. Click the **TS Obs** tab.
2. For editing TS Obs tab properties, see “Editing Total Station Raw Data Files” on page 4-48.

**Editing GPS Obs Point Notes**

1. Click the **GPS Obs** tab.
2. To edit the observation (vector) notes, right-click the observation and click **Properties** on the pop-up menu.
3. On the **Properties** dialog box, click the **General** tab (Figure 4-88 on page 4-66).
4. Edit the **Note** field as needed.
5. Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.
Figure 4-88. Observation Properties – General Tab

**Editing GPS Observation Display Properties**

To change the column order, or add a column from the left panel, or hide any column in the *GPS Obs* tab, click the *Options* dialog box (Figure 4-89).

Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.
Editing TopSURV File Codes

1. Click the Codes tab.
2. To edit the code’s attribute, right-click the code and click New Attribute on the pop-up menu, then select the desired attribute (Figure 4-90).

3. On the Attributes dialog box, enter the parameters for the code’s attribute (Figure 4-91).
4. Click OK.
Later, double-click the attribute to edit it.

**NOTICE**

Codes and attributes already in use for a point cannot be deleted or edited.

5. To edit the code name, right-click the code’s name and click **Properties** on the pop-up menu. Edit the code’s name and click **OK** (Figure 4-92).

![Figure 4-92. Edit Code Name](image)

Click **OK** to set the changes and close the dialog box. Click **Apply** to set the changes and continue editing the point.
Using Files

This chapter discusses file functions available in Topcon Link.

Changing Localization Data

You can use Topcon Link to edit localization data in TopSURV files.

Localization Basics

Localization involves comparing and computing local jobsite coordinates with a global reference system.

A GPS+ system is capable of precise positioning, but the positions it computes are relative to a global reference system defined in terms of a geographic latitude, longitude, and height above the earth’s surface. To be useful for local site work, global GPS coordinates need to be converted into local site coordinates, defined in terms of a distance north and east of some origin point and some distance above an elevation datum. These north, east, and elevation coordinates (often abbreviated to NEZ coordinates) can be regional coordinates system—for example, a state plane system in the United States—or the project’s survey crew may arbitrarily define these coordinates for the specific site. NEZ coordinates must be defined in terms of the construction design data. In either case, a mathematical conversion is necessary to turn global GPS coordinates into NEZ coordinates relative to the locally defined coordinate system.

The basic approach to calculating the mathematical conversion is to provide pairs of point coordinates for each Control Point on the project. A point pair consists of:

- local NEZ coordinates for the point (obtained from the project’s survey crew), and
- global latitude, longitude, and height coordinates for the point.
These pairs of points are needed to calculate a precise mathematical conversion formula for converting all global GPS coordinates (generated in the GPS+ or GPS receiver) to local NEZ coordinates for a particular project.

Use the following guidelines to ensure high-quality localization:

- The surveyor’s local Control Points must be precisely measured. The quality of measurements directly affects accuracies.
- The Control Points should be located more or less evenly around the site. Generally, the more Control Points the better, but if they are clustered together or are all at one section of the site, then localization results will be less than ideal.

A good rule of thumb is to locate Control Points evenly distributed around a perimeter of the site or grading area. While not directly related to quality of localization, the location of Control Points should be elevated, easily accessible, and are not frequently obstructed by trees, buildings, other structures, moving vehicles, etc.

### Horizontal and Vertical Localization Determinations

In Topcon Link (and Topcon Tools and TopSURV), horizontal localization and vertical localization are performed separately.

- Horizontal localizations use two-dimensional conformal transformations. This kind of transformation is also known as a four-parameter similarity transformation (rotation (α), scale and two translation parameters (DX, DY)). To relate the points’ ellipsoidal geodesic coordinates (measured with GNSS receivers) to local plane coordinates (obtained with total stations, etc.), an oblique stereographic map projection is used as an intermediate step:

$$\begin{bmatrix} X_{Local} \\ Y_{Local} \end{bmatrix} = \text{Scale} \cdot \begin{bmatrix} \cos \alpha - \sin \alpha \\ \sin \alpha \cos \alpha \end{bmatrix} \cdot \begin{bmatrix} X_E^{Stereo} \\ Y_E^{Stereo} \end{bmatrix} + \begin{bmatrix} DX \\ DY \end{bmatrix}$$

- Vertical localizations use a three-parameter transformation (one shift (HO) and two slopes (Hx, Hy)) to convert between the points’ ellipsoidal or orthometric heights and the elevations in the
local height system. These three parameters are necessary in order to specify the plane that would adequately model the difference between the local geoid and the WGS84 ellipsoid in the given local area:

\[ H_{Local} = U + H_o + H_x \cdot N_{Stereo} + H_y \cdot E_{Stereo} \]

Topcon Tools (and Topcon Link and TopSURV) uses an algorithm for localization that computes parameters for conversion from WGS84 to a local system using one, two, or more Control Points with known coordinates in both systems. If a geoid is present in the job, Topcon Tools will use the geoid to during the localization. The geoid model is used to correct local heights for the geoid before computer localization parameters; consequently, localization parameters will be different with or without a geoid in the job. The presence of a geoid will not significantly affect localization results when using three or more vertical controls, but will improve localization quality if using less than three vertical controls.

- When using ONE control point, the following assumptions have already been determined (Table 5-1):

**Table 5-1. Localization with One Control Point**

| For Horizontal Localization | The system is oriented North.  
The Horizontal scale factor \( (K_h) \) is set to one.  
The horizontal offsets \((DX, DY)\) are computed. |
|-----------------------------|------------------------------------------------------------------------------------------|
| For Vertical Localization   | The components of the deflection of vertical are set to zero.  
The vertical offset is determined. |
| For Horizontal and Vertical Localization | The system is oriented North.  
The combined scale factor is set to  
\[ K_{comb} = K_h \cdot K_v = (1 \cdot (1 + U/R)) \], where \( R \) is the average radius of curvature.  
The components of deflection of vertical are set to zero.  
The horizontal \((DX, DY)\) and vertical \((DH)\) offsets, azimuth (rotation), and scale factor are computed. |
When using TWO control points, the following have already been determined for horizontal and vertical localization:

- The components of deflection of vertical are set to zero.
- The horizontal (DX, DY) and vertical (DH) offsets, azimuth (rotation), and scale factor are computed.

When using THREE or more control points, the horizontal (DX, DY) and vertical (DH) offsets, azimuth (rotation), scale factor, and components of deflection of vertical are computed for horizontal and vertical localization.

**Accuracy Estimation for Localization Parameters**

Localization parameters are estimated using the least-mean-square method in the following two instances:

- When three or more control points are used for horizontal localization.
- When three or more control points are available for horizontal and vertical localization.

The Localization dialog box will display the residuals for all control points (Figure 5-1).
When using fewer than three control points for localization, the residual are computed with the following values:

- When using ONE control point, the horizontal and vertical residuals will equal zero.
- When using TWO control points, the horizontal residuals are equal to zero, but the vertical residual can have a value different from zero.
- When using THREE control points, the horizontal residuals are equal to zero, but the vertical residual can have a value different from zero.

**Editing Localization Parameters**

Use the *Localization* dialog box to edit and save localization parameters in an open TopSURV file.

To open the *Localization* window for the TopSURV file, open a TopSURV file click **Process ▶ Localization**.

The localization parameters contained in the TopSURV file will be shown in the *Localization* dialog box (Figure 5-2).

**Figure 5-2. Localization Data in the TopSURV File**

The left panel of the *Localization* window displays pairs of points used for localization:

- **WGS Point** – Control Point in the WGS-84 coordinate system.
- **Local Point** – Control Point in the Local coordinate system.
Using Files

- **Use** – shows the localization status of the Control Point (No, Vertical, Horizontal, Horizontal and Vertical)
- **NResidual / EResidual / HResidual** – display the residuals along N, E, H axes for all Control Points

The right panel displays the localization parameters for the Control Points.

Using the **Localization** dialog box, you can:

- **Remove a Control Point**
  
  To remove a pair of Control Points, select desired row in the **Localization** window and click **Remove Point**.

- **Add a new Control Point**
  
  To add a new Control Point (Figure 5-3), click **Add Point** and select the desired point from the drop-down list in **WGS Point** column. Then select the corresponding point from the drop-down list in **Local Point**.

- **Change a Control Point**
  
  To change a Control Point, do one the following:
  - Click in the **WGS Point / Local Point** column and select the corresponding point (Figure 5-4).
Changing Localization Data

– Right-click the Control Point and click **Properties** on the pop-up menu. Select the corresponding *WGS Point/Local Point* from the drop-down list (Figure 5-5).

*Figure 5-5. Control Point Properties*

- **Change the Localization Status of the Control Point.**
  To change a Control Point’s status, do one the following:
  – Click in the *Use* column and select the corresponding localization type (Figure 5-6).

*Figure 5-6. Change Localization Status*

– Right-click the Control Point and select **Properties** from the pop-up menu. Select the corresponding *WGS Point/Local Point* from the drop-down list (Figure 5-7).

*Figure 5-7. Control Point Properties – Select of the Localization Type*
• Edit the Coordinates of a Control Point

To edit the coordinate of the Control Point do the following:

1. For editing WGS Control Point, set the WGS-84 system. For editing Local Control Point set the local coordinate system.
2. Open the Point tab.
3. Right-click the Control Point and click Properties on the pop-up menu.
4. On the Properties dialog box, click the Coordinates tab (Figure 5-8).

![Figure 5-8. Point Properties – Coordinate Tab](image)

5. Depending on the type of the coordinate file edit the WGS84 Latitude or Ground Northing/Grid Northing, WGS84 Longitude or Ground Easting/Grid Easting, and WGS84 Ell.Height or Elevation fields as needed.
6. Click OK to set the changes and close the dialog box. Click Apply to set the changes and continue editing the point.

NOTICE

After editing any of the localization parameters, the localization is automatically recomputed. However, you can click OK to make absolutely sure it has been recomputed.
Computing Coordinates

To compute the coordinates of the points in a raw data file or TopSURV file using the information the file contains:

1. Open a raw data or TopSURV file.
2. Click **Process ▶ Compute Coordinates**.

**NOTICE**

If none of the points have known coordinates, Topcon Link uses a point with (0, 0, 0) coordinates as the beginning point.

Topcon Link computes points coordinates and adds/writes them to the Total Station raw data file or TopSURV file (Figure 5-9).

![Figure 5-9. Raw Data File](image)

**WARNING**

If the base station has an “Unknown” antenna type, Topcon Link will not recalculate the coordinates of the points after editing base station coordinates or antenna height. To recalculate the coordinates of the points, specify the antenna type for the base station.
NOTICE

When editing data (point coordinates, antenna/instrument/reflectors, antenna heights, antenna types, antenna height measuring methods, point types, BKB azimuths, offsets), coordinate recomputation will be performed after clicking the Calculate Coordinate button.

Traverse Adjustment

The procedure combines points coordinates computation and network adjustment.

Network adjustment methods of adjustment may be classified as:

- Approximate adjustment – includes Interior Angle Balancing, Azimuth Balancing, Compass rule (Bowditch Rule), Transit Rule, and the Crandall method.
- Rigorous adjustment – includes the method of least squares.

Traditional methods of approximate traverse adjustment have been developed to accommodate prevailing conditions in certain combinations of angular and linear precisions in the observations.

In this respect, three combinations are still common.

- Precision in angles or directions exceeds its equivalent in linear distance observations.
- Precision in angles or directions essentially is equal to its equivalent in the precision of distances.
- Precision in distances exceeds that in angles and directions.
Setting the Adjustment Type

1. To select a network adjustment type, click **Process ▶ Process Properties**.

2. On the **Process properties** dialog box, select the **Compute Coordinates** tab (Figure 5-11) and choose one of the following Adjustment types (Figure 5-10).
   - None – requires apriori values
   - Least Squares – requires apriori values; see “Least Squares Method” on page 5-13 for details
   - Compass Rule – see “Compass Rule” on page 5-13 for details
   - Transit – see “Transit Rule” on page 5-14 for details
   - Crandall – see “Crandall Method” on page 5-14 for details
   - Angle Balance – see “Interior Angle Balancing Method” on page 5-15 for details

   ![Figure 5-10. Adjustment Type](image)

   The adjustment type determines whether or not the point coordinates will be fixed. When adjusting with Least Squares, or computing without adjustment (None), coordinates of the network points can be fixed. When adjusting with Angle Balance, Transit, Crandall, or Compass Rule, coordinates of the first network point and the first and last azimuths of the network are automatically fixed.

   ![Figure 5-11. Process Properties – Compute Coordinates](image)
3. Select an azimuth balancing parameter (Figure 5-11 on page 5-11). See “Azimuth Balancing Method” on page 5-15 for details.

4. For None or Least Squares adjustment types, select the apriori values of error of linear and angular measurements (Figure 5-12). The None method is used only for computing a resection.

5. Click OK.

![Figure 5-12. Assign Apriori Values for Least Squares Method](image)

**Setting the Refraction Coefficient**

To correct the vertical angle for the earth’s curvature and the refraction in the atmosphere, select the TS-Computation tab on the Process properties dialog box and select the appropriate refraction coefficient (Figure 5-13).

![Figure 5-13. Process Properties – TS-Computation](image)
Least Squares Method

The method of least squares provides the most rigorous adjustment:

- allows for variation in precision in the observations,
- minimizes the random variations in the observations,
- provides the best estimates for positions of all traverse stations, and
- yields statistics relative to the accuracies of adjustment observations and positions.

This method requires more of a computational effort than the approximate adjustment.

Compass Rule

The compass rule was developed for the second combination of precisions and observations, and can be shown to be rigorous when the angular precision equals the precision in linear distances condition is rigidly enforced.

With the compass rule, adjustments are applied to both latitudes and departures in proportion to the length of the lines. In other words, the longer a line, the greater are its latitude and departure adjustments (and vice versa), as shown in the following formulas:

$$\frac{\text{Adjustment in Latitude } AB}{\text{Latitude Misclosure}} = \frac{\text{Length of } AB}{\text{Perimeter of Traverse}}$$

$$\frac{\text{Adjustment in Departure } AB}{\text{Departure Misclosure}} = \frac{\text{Length of } AB}{\text{Perimeter of Traverse}}$$

This method works for closed traverses or traverses between two known points.
Transit Rule

The transit rule was developed for the first combination of precisions and observations.

With the transit rule, adjustments are applied to respective latitudes in proportion to their lengths; thus, the longer a latitude, the greater is its adjustment (and vice versa). Similarly, adjustments are applied to respective departures in proportion to their lengths. Adjustments can be computed using the following formulas:

\[
\frac{\text{Adjustment in Latitude}_{AB}}{\text{Latitude Misclosure}} = \frac{\text{Latitude of AB}}{\text{Absolute Sum of Latitudes}}
\]

\[
\frac{\text{Adjustment in Departure}_{AB}}{\text{Departure Misclosure}} = \frac{\text{Departure of AB}}{\text{Absolute Sum of Departures}}
\]

This method works for closed traverses or traverses between two known points.

Crandall Method

The Crandall method is a rather complicated procedure that is more rigorous than either the compass or transit rule, requiring substantially more computations.

In the Crandall method of traverse adjustment, the angular error is equally distributed to all measured angles. The adjusted angles are then held fixed and all remaining corrections placed in the linear measurements through a weighted, least-squares procedure. The Crandall method is suitable for adjusting traverses where the linear measurements contain larger random errors than the angular measurements.

Because of the angle balancing, this method works only for closed traverses or traverses where azimuths are known at beginning and ending point, plus beginning and ending points are known for allocating distance corrections.
User-defined Parameters

Interior Angle Balancing Method

The Interior Angle Balancing method. The sum of all interior angles of a closed traverse (loop) should equal \((n-2)\times 180\) degrees. The discrepancy should be allocated equally to each interior angle. Clearly works only for closed traverses (loops).

Azimuth Balancing Method

The Azimuth Balancing method. Knowing azimuths at beginning and ending of traverse, calculate azimuth misclosure and distribute equally to all direction measurements. Works for open traverses.

User-defined Parameters

1. To change the data representation in the open file, click **File ➤ Configuration**.
2. Click **Display** on the **Configuration** dialog box (Figure 5-14).

![Figure 5-14. Job Configuration – Click Display](image)

3. Edit the following parameters.
   - The **Precisions** tab (Figure 5-15 on page 5-16) defines the number of digits after decimal.
Using Files

5-16

The Time tab (Figure 5-16) sets the GPS time zone offset.

The Roads tab (Figure 5-17) sets the type of number to use for the centerline position.
• The **Angles** tab (Figure 5-18) defines an angle representation.

![Figure 5-18. Angles Tab](image)

• The **Strings** tab (Figure 5-19) contains the field that switches on/off the output alphanumeric code describing surveyed points on the screen.

![Figure 5-19. Strings Tab](image)

4. To view, add, or remove available geoid files, click **Coordinate Systems** in the **Configuration** dialog box (Figure 5-20).

![Figure 5-20. Configuration – Coordinate Systems](image)
To add a geoid file click **Add** and select the desired *.bin* file in **Open** dialog box and click **Open**.

5. To change autosave time intervals when editing a file, click **Save** in the **Configuration** dialog box and type the desired interval (Figure 5-21).

**Figure 5-21. Configuration – Click Save and Set Backup Interval**

- Topcon Link automatically creates a reserve copy of the editing file after the expiration of the entered time interval.
- After saving a file, Topcon Link automatically deletes the reserve copy.
- The default time interval is 10 minutes; the lowest time interval is 1 minute. To switch the autosaving off, type a “0” in the **AutoSave Interval** field.
- If starting Topcon Link after an abnormal termination when the edited file was not saved, Topcon Link opens a reserve copy of the edited file and marks it as “Recovered”.
6. To change the adjustment type click **Process** (Figure 5-22).

![Figure 5-22. Configuration – Set Process](image)

**Layers View Options**

If the Layers view displayed when the job was closed, it will display when the job is opened. To view or hide the Layers view, click **View ▶ Layers**.

The Layers view lists all layers and their plotting style used in the file (Figure 5-23):

- **Name** – the name of the layer.
- **Visible** – shows (select Yes) or hides (select No) the layer on the **Cad View** and **3D View**.
- **Line Style/Line Width/Line Color/Point Symbol** – displays the plotting style (attributes) of the layer.
- **Note** – displays user comments.

![Figure 5-23. Layers View](image)
Tabular View Options

To change the column order or hide any column in any tab click View ➤ Tabular View Option.

1. Select the desired tab in the Tabular View Option window (Figure 5-24).
2. On the tab select the desired entry (icon, point from, point to, reflector height, etc.), then:
   – Use the Move Right (>>) button to move entries from the left field to the right field. The order of names in the right field must correspond to the order of names in the opened TS raw file.
   – Use the Move Left (<<) button to move entries out of the right panel and back to the left panel.
   – Use the Move Up and Move Down buttons to move names in the right panel up and down.
3. To save the tabular view options click OK.

Figure 5-24. Tabular View Options Examples
Printing Files

To print a coordinates file, TS raw data file, or TopSURV file:

1. Open the desired file.

2. Click File ➤ Print Setup and define the Printer Properties, Paper Size, and Orientation parameters.

3. On the file window, click the desired tab or a left/right panel.

4. Click File ➤ Print Preview. Check the file representation (Figure 5-25). Repeat steps 2 and 3 as needed.

5. Click File ➤ Print menu, click OK.
Using Files

Notes:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Receiver Options and Offset Types

Option Authorization File

Topcon Positioning Systems issues an Option Authorization File (OAF) to enable the specific options that customers purchase. An Option Authorization File allows customers to customize and configure the receiver according to particular needs, thus only purchasing those options needed.

Typically, all receivers ship with a temporary OAF that allows the it to be used for a predetermined period of time. When the receiver is purchased, a new OAF permanently activates desired, purchased options. Receiver options remain intact when clearing the NVRAM or resetting the receiver.

The OAF enables the following kinds of functions. For a complete list of available options and details, visit the TPS website (http://www.topcongps.com/tech/index.html) or consult your TPS dealer.

- Type of signal (standard L1; optional L2)
- Memory (standard 0Mb; optional up to 128Mb)
- Update rate (standard 1Hz; optional 5, 10, or 20Hz)
- RTK at 1Hz, 5Hz, 10Hz, and 20Hz
- RTCM/CMR Input/Output
- Event marker
- Co-Op tracking
- Advanced multipath reduction
- Wide Area Augmentation System (WAAS)
- Receiver Autonomous Integrity Monitoring (RAIM)
- 1 PPS (Pulse-Per-Second; a timing signal)
Offset Types in Topcon Link

Topcon Link allows editing offset values and calculations for offset point coordinates for the following types of offsets.

Offsets From an Observation Line

Offsets from the observation line are used only in TS measurements. Figure A-1 demonstrates offsets from the observation line with the signs for the offset.

![Figure A-1. Measuring Offsets From Observation Line](image)

From the *Ts Obs* tab, use the *Properties* dialog box and the *Offset* tab (Figure A-3 on page A-3) to add/edit offset values.

- Offset Along – the distance from the Prism Point to the projection of the Offset Point along the line of sight.
- Offset Across – the distance from the offset Point to the line of sight, either to the left or to the right of the line.
- Offset Height – the height difference from the prism point to the offset point.
Offset Point to Line

The offsets from the reference line formed by the reference points (point to line offsets) are used in TS and GPS measurements. Figure A-3 demonstrates offsets from point to line with the signs of the offsets.

Figure A-3. Measuring Offset Point to Line
From the *Point* tab, use the *Properties* dialog box and the *Offset* tab (Figure A-4) to add/edit offset values for a coordinate and TopSURV file.

- From Point – the start point of the reference line (Point 1)
- To Point – the end point of the reference line (Point 2)
- Offset Dist – the distance along the reference line from the prism or the rover GPS antenna point to the offset point
- Offset Across – the distance perpendicular to the reference line from the prism or the rover GPS antenna point to the offset point
- Height is relative – the height difference from the prism point to the offset point.
- Height is absolute – the absolute height of the offset point.

![Figure A-4. Point Properties – Offset Tab](image-url)
Offsets From a Line with Known Azimuth

The offsets from a line with known azimuth are used in TS and GPS measurements. Figure A-5 demonstrates offsets from the line with known azimuth with the signs of the offsets.

Figure A-5. Measuring Offset from the Line with Known Azimuth

From the Point tab for TS measurements or the GPS Occupation tab for GPS measurement, use the Properties dialog box and the Offset tab (Figure A-6 and Figure A-7 on page A-6) to add/edit offset values in a TopSURV file.

- Offset Azimuth – offset line azimuth
- Offset Dist – the distance along the line with known azimuth from the rover GPS antenna point to the offset point
- Offset Across – the distance perpendicular to the line with known azimuth from the rover GPS antenna point to the offset point
Receiver Options and Offset Types

- Offset Ht – the height difference from the rover GPS antenna to the offset point
- Height is absolute – the absolute height of the offset point

Figure A-6. Point Properties – Offset Tab

Figure A-7. GPS Occupation Properties – Offset Tab
Creating a Regional Geoid Model File

If geoid heights (differences between ellipsoidal and orthometric heights) for the nodes of a regular grid are known, you can create a Regional Geoid Model File (*.rgm).

To create this ASCII file with a *.rgm extension, manually enter geoid heights in the following format:

LAT, LON, n_row, n_column, step_lat, step_lon, geoid_direction, ellipsoid;

H1 H2 H3
H4 H5 H6
H7 H8 H9

where

- LAT, LON – latitude (GG MM SS) and longitude (GG MM SS) of the start point for user’s Regional Geoid Model
  - Latitudes are positive for the Northern Hemisphere.
  - Longitudes are positive for the Eastern Hemisphere.
- n_row – the number of rows in the file,
- n_column – the number of columns in the file,
- step_lat – grid step along parallels (MM SS)
- step_lon – grid step along meridians (MM SS)
• `geoid_direction` – direction for entering geoid heights
  (Table B-1):

  **Table B-1. Entering Geoid Heights**

<table>
<thead>
<tr>
<th>Height</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>NE from north to east</td>
<td>![Diagram of NE direction]</td>
</tr>
<tr>
<td>EN from east to north</td>
<td>![Diagram of EN direction]</td>
</tr>
<tr>
<td>WS from west to south</td>
<td>![Diagram of WS direction]</td>
</tr>
</tbody>
</table>

• `ellipsoid` – the ellipsoid type that the given regional geoid is based on

• H1,H2... – geoid height in the node (meter)

An example of this format can be seen in “Regional Geoid Model File” on page C-15.

Using Topcon Link, convert the Regional Geoid Model file to a Topcon geoid file (*.gff).
Sample File Formats

Coordinate File Formats

Topcon Link can send, receive, and convert a number of different data types. Formats of files that are ASCII are listed below. These sample files are used in the Topcon Link Reference Manual screen shots.

GTS-6 Points Coordinate Format

GTS-6 coordinate input and output has the same format.

Name, X(easting), Y(northing), Z(elevation)

_+1  x+00000009939_ y+00000013376_ z+00000001119
_+10 _ x+00000018482_ y+00000015981_ z+00000000022
_+11 _ x+00000015360_ y+00000016995_ z+00000000018
_+1113 _ x+00000013121_ y+00000012355_ z+00000001882
_+1114 _ x+00000010307_ y+00000013914_ z+00000000721
_+12 _ x+00000013520_ y+00000015221_ z+00000000000
_+13 _ x+00000003993_ y+00000009992_ z+00000000096
_+14 _ x+00000006912_ y+00000007631_ z+00000000407
_+15 _ x+00000002577_ y+00000003569_ z+00000000788
_+16 _ x+00000012071_ y+00000003714_ z+00000000835
_+17 _ x+00000015842_ y+00000001442_ z+000000002275
_+18 _ x+00000021133_ y+00000002553_ z+00000000500
_+19 _ x+00000017531_ y+00000008498_ z+00000000020
_+MARK _ x+00000010000_ y+000000010000_ z+000000000500
_+MARK1 _ x+000000010033_ y+000000009975_ z+000000000959
_+MARK2 _ x+00000010006_ y+00000010001_ z+000000000904
_+ST1 _ x+00000013856_ y+00000007047_ z+00000000258
_+ST1-1 _ x+00000013856_ y+00000007047_ z+00000000258
_+ST1-3 _ x+00000013830_ y+00000007105_ z+00000000927
_+ST2 _ x+00000014870_ y+00000010679_ z+00000000204
Sample File Formats

._+ST2-1  _ x+00000014874_  y+00000010625_  z-00000001005
._+ST2-2  _ x+00000014870_  y+00000010679_  z-00000000204_

GTS-7 Points Coordinate Format

Name, Easting, Northing, Elevation
1, 13.37600, 9.93900, 1.11900,
2, 15.22100, 3.13500, 4.27700,
3, 9.99200, 3.99300, -0.09600,
4, 7.63100, 6.91200, 0.40700,
5, 3.56900, 2.57700, 0.78800,
6, 3.71400, 12.07100, -0.83500,
7, 1.44200, 15.84200, 2.27500,
8, 2.55300, 21.13300, 0.50000,
9, 8.49800, 17.53100, -1.32000,
10, 15.98100, 18.48200, 0.02200,
11, 16.99500, 15.36000, 0.01800,
12, 13.37100, 13.52000, 1.00000,
1113, 12.35500, 13.12100, -1.88200,
1114, 13.91400, 10.30700, 0.72100,
MARK, 10.00000, 10.00000, 0.50000,
MARK1, 9.97500, 10.03300, -0.95900,
MARK2, 10.00100, 10.00600, -0.90400,
ST1, 7.04700, 13.85600, -0.25800,
ST1-1, 7.04700, 13.85600, -0.25800,
ST1-3, 7.10500, 13.83000, -0.92700,
ST2, 10.67900, 14.87000, -0.20400,
ST2-1, 10.62500, 14.87400, -1.00500,
ST2-2, 10.67900, 14.87000, -0.20400,
**Name,E,N,Z,Code Coordinate Format**

Name, Easting, Northing, Elevation, Code

<table>
<thead>
<tr>
<th>Name</th>
<th>Easting</th>
<th>Northing</th>
<th>Elevation</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>13.37600</td>
<td>9.93900</td>
<td>1.11900</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>15.22100</td>
<td>3.13500</td>
<td>4.27700</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>9.99200</td>
<td>3.99300</td>
<td>-0.09600</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>7.63100</td>
<td>6.91200</td>
<td>0.40700</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5.35690</td>
<td>2.57700</td>
<td>0.78800</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>6.371400</td>
<td>12.07100</td>
<td>-0.83500</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>7.144200</td>
<td>15.84200</td>
<td>2.27500</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>8.255300</td>
<td>21.13300</td>
<td>0.50000</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>9.49800</td>
<td>17.53100</td>
<td>-1.32000</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>10.198100</td>
<td>18.48200</td>
<td>0.02200</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>11.169500</td>
<td>15.36000</td>
<td>0.01800</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>12.133700</td>
<td>13.52000</td>
<td>1.00000</td>
<td></td>
</tr>
<tr>
<td>1113</td>
<td>12.35500</td>
<td>13.12100</td>
<td>-1.88200</td>
<td></td>
</tr>
<tr>
<td>1114</td>
<td>13.91400</td>
<td>10.30700</td>
<td>-0.95900</td>
<td></td>
</tr>
<tr>
<td>MARK</td>
<td>10.00000</td>
<td>10.00000</td>
<td>-0.90400</td>
<td></td>
</tr>
<tr>
<td>MARK1</td>
<td>9.97500</td>
<td>10.00000</td>
<td>-0.95900</td>
<td></td>
</tr>
<tr>
<td>MARK2</td>
<td>10.00100</td>
<td>10.00600</td>
<td>-0.90400</td>
<td></td>
</tr>
<tr>
<td>ST1</td>
<td>13.704700</td>
<td>13.85600</td>
<td>-0.25800</td>
<td></td>
</tr>
<tr>
<td>ST1-1</td>
<td>13.704700</td>
<td>13.85600</td>
<td>-0.25800</td>
<td></td>
</tr>
<tr>
<td>ST1-3</td>
<td>13.70500</td>
<td>13.83000</td>
<td>-0.92700</td>
<td></td>
</tr>
<tr>
<td>ST2</td>
<td>10.67900</td>
<td>14.87000</td>
<td>-0.20400</td>
<td></td>
</tr>
<tr>
<td>ST2-1</td>
<td>10.62500</td>
<td>14.87400</td>
<td>-1.00500</td>
<td></td>
</tr>
<tr>
<td>ST2-2</td>
<td>10.67900</td>
<td>14.87000</td>
<td>-0.20400</td>
<td></td>
</tr>
</tbody>
</table>

**Name,Lat,Lon,Ht,Code Coordinate Format**

Name, Lat, Lon, Ht, Code

<table>
<thead>
<tr>
<th>Name</th>
<th>Lat, Lon, Ht</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0°00'00.32&quot;N,0°00'00.43&quot;E,1.11900</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0°00'00.03&quot;N,0°00'00.04&quot;E,1.32700</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0°00'00.13&quot;N,0°00'00.32&quot;E,0.09600</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0°00'00.23&quot;N,0°00'00.25&quot;E,0.40700</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0°00'00.08&quot;N,0°00'00.12&quot;E,0.78800</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>0°00'00.39&quot;N,0°00'00.12&quot;E,-0.83500</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>0°00'00.52&quot;N,0°00'00.05&quot;E,2.27500</td>
<td></td>
</tr>
</tbody>
</table>
8.0°00'00.69"N,0°00'00.08"E,0.50000
9.0°00'00.57"N,0°00'00.28"E,-1.32000
10.0°00'00.60"N,0°00'00.52"E,0.02200
11.0°00'00.50"N,0°00'00.55"E,0.01800
12.0°00'00.44"N,0°00'00.43"E,1.00000
1113.0°00'00.43"N,0°00'00.40"E,-1.88200
1114.0°00'00.34"N,0°00'00.45"E,0.72100
MARK,0°00'00.33"N,0°00'00.32"E,0.50000
MARK1,0°00'00.33"N,0°00'00.32"E,-0.95900
MARK2,0°00'00.33"N,0°00'00.32"E,-0.90400
ST1,0°00'00.45"N,0°00'00.23"E,-0.25800
ST1-1,0°00'00.45"N,0°00'00.23"E,-0.25800
ST1-3,0°00'00.45"N,0°00'00.23"E,-0.92700
ST2,0°00'00.49"N,0°00'00.35"E,-0.20400
ST2-1,0°00'00.49"N,0°00'00.34"E,-1.00500
ST2-2,0°00'00.49"N,0°00'00.35"E,-0.20400

Name,N,E,Z,Code Coordinate Format

Name, N, E, Z, Code
1.93900,13.37600,1.11900
2.3.13500,15.22100,4.27700
3.3.99300,9.99200,-0.09600
4.6.91200,7.63100,0.40700
5.2.57700,3.56900,0.78800
6.12.07100,3.71400,-0.83500
7.15.84200,1.44200,2.27500
8.21.13300,2.55300,0.50000
9.17.53100,8.49800,-1.32000
10.18.48200,15.98100,0.02200
11.15.36000,16.99500,0.01800
12.13.52000,13.37100,1.00000
1113.13.12100,12.35500,-1.88200
1114.10.30700,13.91400,0.72100
MARK,10.00000,10.00000,0.50000
MARK1,10.03300,9.97500,-0.95900
MARK2,10.00600,10.00100,-0.90400
ST1,13.85600,7.04700,-0.25800
Raw Data File Formats

GTS-6 Raw Format

See the GTS-6 interface manual for details.

ST1-1, 13.85600, 7.04700, -0.25800
ST1-3, 13.83000, 7.10500, -0.92700
ST2-1, 14.87000, 10.67900, -0.20400
ST2-1, 14.87400, 10.62500, -1.00500
ST2-2, 14.87000, 10.67900, -0.20400
Sample File Formats

GTS-7 Raw Format

The general format for each record is:

CONTROL WORD  field1,…….,fieldn

  JOB           job name, description
  DATE          date, name
  NAME          surveyors name
  INST          instrument id
  UNITS         Meter/Feet, Degree/Gon
  SCALE         grid factor, scale factor, elevation
  ATMOS         temp, press
  STN           ptno, ins ht, stn id
  XYZ           X(easting), Y(northing), Z(elevation)
  BKB           ptno, backsight bearing, backsight angle
  BS            ptno[,target height]
  FS            ptno,target height, pt code[,string number]
  SS            ptno,target height, pt code[,string number]
Raw Data File Formats

<table>
<thead>
<tr>
<th>CTL</th>
<th>control code[,pt code 2[,string no 2]][optional]</th>
</tr>
</thead>
<tbody>
<tr>
<td>HV</td>
<td>HA, VA</td>
</tr>
<tr>
<td>SD</td>
<td>HA, VA, SD</td>
</tr>
<tr>
<td>HD</td>
<td>HA, HD, VD</td>
</tr>
<tr>
<td>OFFSET</td>
<td>- radial offset, tangential offset, vertical offset</td>
</tr>
<tr>
<td>NOTE</td>
<td>comments</td>
</tr>
<tr>
<td>XYZ</td>
<td>if present follows the STN record</td>
</tr>
<tr>
<td>BKB</td>
<td>if present follows the BKB record or STN record if no BKB</td>
</tr>
<tr>
<td>CTL</td>
<td>if present follows the FS or SS header record</td>
</tr>
<tr>
<td>HV,SD,orHD</td>
<td>- must follow a BS, FS, or SS header and follows the CTL if present</td>
</tr>
<tr>
<td>OFFSET</td>
<td>- may follow any SD or HD record</td>
</tr>
</tbody>
</table>

TTools v1.0

JOB    C:\Download\777.raw,Comment
NAME   TopconTools
INST   TS
UNITS  M,D
SCALE  1.000000,1.000000,0.000000
DATE   00/00/00,00:00
TEMP   0.000,000
STN    MARK,1.52000,STAT
BKB    ST1,0.00000,322.33160
XYZ    13.85600,7.04700,-0.25800
BS     ST1,1.60000
SD     -37.26440,97.57060,4.90200
SS     ST1,1.60000,STAT
SD     -37.26440,97.57060,4.90400
XYZ    13.85600,7.04700,-0.25800
SS     ST2,1.60000
SD     7.56170,97.13460,4.95600
XYZ    14.87000,10.67900,-0.20400
SS     ST2,1.60000,STAT
SD     7.56170,97.13470,4.95600
XYZ    14.87000,10.67900,-0.20400
SS     1.160000,TREE
SD     91.02230,78.18030,3.44800
### Sample File Formats

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Coordinates</th>
</tr>
</thead>
<tbody>
<tr>
<td>SS</td>
<td>2.1.60000, TREE</td>
<td>42.44560, 65.54220, 9.44800</td>
</tr>
<tr>
<td>SD</td>
<td>3.1.60000, TREE</td>
<td>-179.55290, 94.54260, 6.02900</td>
</tr>
<tr>
<td>SS</td>
<td>4.1.60000, TREE</td>
<td>-142.30250, 90.11250, 3.89200</td>
</tr>
<tr>
<td>STN</td>
<td>ST1-1.52000, STAT</td>
<td>142.33160, 97.20510, 4.85400</td>
</tr>
<tr>
<td>BKB</td>
<td>MARK1.0.0000,142.33160</td>
<td>10.03300, 9.97500, -0.95900</td>
</tr>
<tr>
<td>XYZ</td>
<td>MARK1.1.60000</td>
<td>142.33160, 97.20510, 4.85600</td>
</tr>
<tr>
<td>BS</td>
<td>MARK2.0.0000, STAT</td>
<td>142.33160, 97.20510, 4.85600</td>
</tr>
<tr>
<td>XYZ</td>
<td>ST2-1.60000, STAT</td>
<td>74.07150, 100.10080, 3.78000</td>
</tr>
<tr>
<td>SS</td>
<td>ST2-1.60000, STAT</td>
<td>14.87400, 10.62500, -1.00500</td>
</tr>
<tr>
<td>SD</td>
<td>ST2-1.60000, STAT</td>
<td>6.1.60000, TREE</td>
</tr>
<tr>
<td>SS</td>
<td>-118.10020,97.29030,3.81300</td>
<td>7.1.60000, TREE</td>
</tr>
<tr>
<td>SD</td>
<td>-70.29320,66.16350,6.49600</td>
<td>8.1.60000, TREE</td>
</tr>
<tr>
<td>SS</td>
<td>-31.41500,84.24190,8.59400</td>
<td>STN ST2-2.1.52000, STAT</td>
</tr>
<tr>
<td>BKB</td>
<td>MARK2.0.0000, STAT</td>
<td>10.00600, 10.00100, -0.90400</td>
</tr>
<tr>
<td>XYZ</td>
<td>MARK2.1.60000</td>
<td>10.00600, 10.00100, -0.90400</td>
</tr>
<tr>
<td>BS</td>
<td>ST1-3.1.60000, STAT</td>
<td>106.13530, 99.47420, 3.77700</td>
</tr>
</tbody>
</table>
GTS-7+ Raw Format

The GTS-7+ format is similar to the GTS-7 format, but also saves measured points SideShots coordinates after calculating coordinates in Topcon Link.

TOPCON XML File Format

```
<?xml version="1.0"?>
<data>
<Point>
<PointNumber>1</PointNumber><Code>TREE</Code></Point>
<PointNumber>2</PointNumber><Code>TREE</Code></Point>
<PointNumber>3</PointNumber><Code>TREE</Code></Point>
<PointNumber>4</PointNumber><Code>TREE</Code></Point>
<PointNumber>5</PointNumber><Code>TREE</Code></Point>
<PointNumber>6</PointNumber><Code>TREE</Code></Point>
<PointNumber>7</PointNumber><Code>TREE</Code></Point>
<PointNumber>8</PointNumber><Code>TREE</Code></Point>
<PointNumber>9</PointNumber><Code>TREE</Code></Point>
<PointNumber>10</PointNumber><Code>TREE</Code></Point>
```

XYZ  13.83000,7.10500,-0.92700
SS   ST1-3,1.60000,STAT
SD   -106.13530,99.47410,3.77700
XYZ  13.83000,7.10500,-0.92700
SS   9,1.60000,TREE
SD   -39.20590,106.45170,3.59300
SS   10,1.60000,TREE
SD   55.44140,87.16050,6.4200
SS   11,1.60000,TREE
SD   85.33390,87.16050,6.34200
SS   12,1.60000,TREE
SD   116.38030,66.54380,3.27300
SS   13,1.60000,TREE
SD   136.13430,123.25050,2.90200
SS   14,1.60000,TREE
SD   144.40010,79.48560,5.68300
BacksightAngle><Northing>45.45932</Northing><Easting>23.12008</Easting><Height>-0.84646</Height><BacksightPoint><Observation><AngleUnitIndicator>DMS</AngleUnitIndicator><DistanceUnitIndicator>Feet</DistanceUnitIndicator><PointNumber>14</PointNumber><Code1>TREE</Code1><ObsType>Shotsight</ObsType><PrismHeight>5.24934</PrismHeight><HorizontalAngle>144.40010</HorizontalAngle><SlopeDistance>18.64501</SlopeDistance><HorizontalDistance>18.35302</HorizontalDistance><VerticalAngle>79.48560</VerticalAngle><VerticalDistance>3.29677</VerticalDistance><Observation></Observation></Station></data>

**DXF Format**

```
0
SECTION
  2
  9
$CECOLOR
    62
    0
    9
$EXTMIN
    10
    0.3245
    20
    0.3245
    9
$EXTMAX
    10
    0.3245
    20
    0.3245
    9
$LIMMIN
    10
    7.0470
    20
    10.0060
```

P/N 7010-0522 C-11
Sample File Formats

9
SLIMMAX
10
11.1658
20
15.0363
0
ENDSEC
0
1_point_names
70
0
6
DASHED
62
255
0
LAYER
2
2_comment
70
0
6
DASHED1
62
5
0
ENDTAB
0
ENDSEC
0
SECTION
BLOCKS
0
BLOCK
8
0
2
MARK1
70
2
10
9.9750
20
10.0330
30
-0.9590
0

POINT
8
0
10
9.9750
20
10.0330
30
-0.9590
0

ATTDEF
8
SEQEND
0

INSERT
8
0
66
1
2
ST2-1
10
10.6250
20
14.8740
30
-1.0050
0
Sample File Formats

SEQEND
0
ENDSEC
0
EOF

**LandXML File Format**

```xml
<?xml version="1.0"?>
<LandXML xmlns="http://www.landxml.org/schema/LandXML-1.0"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://www.landxml.org/schema/LandXML-1.0 http://www.landxml.org/schema/LandXML-1.0/LandXML-1.0.xsd" version="1.0"
date="10/24/2003" time="20:30:47" readOnly="false" language="English">
  <Project name=""/>
  <Units>
    <Metric linearUnit="meter" areaUnit="squareMeter" volumeUnit="cubicMeter"
temperatureUnit="celsius" pressureUnit="mmHG" angularUnit="decimal degrees"
directionUnit="decimal degrees"/>
  </Units>
  <Application name="TopSurv" manufacturer="Topcon" version="1.10"
desc="OnBoard Version" manufacturerURL="www.topcon.com"/>
  <CgPoints>
    <CgPoint name="0">9807019.29622078 973450.31989092 213.271773</CgPoint>
    <CgPoint name="Auto1">9806910.67604002 973580.14059322 217.066318</CgPoint>
    <CgPoint name="Auto2">9806910.65496200 973580.16603014 217.072248</CgPoint>
    <CgPoint name="Auto3">9806910.67343960 973580.14156662 217.069849</CgPoint>
    <CgPoint name="Topo1">9806910.66581991 973580.14734168 217.080830</CgPoint>
    <CgPoint name="Topo2">9806910.66050706 973580.15343608 217.075792</CgPoint>
    <CgPoint name="Topo3">9806910.65094054 973580.16451221 217.072649</CgPoint>
  </CgPoints>
</LandXML>
```
Regional Geoid Model File

40 36 10, -4 30 00, 4, 5, 2 00, 2 00, SE, WGS84;
16.16 11.11 6.6 1.1 17.17
12.12 7.7 2.2 18.18 13.13
8.8 3.3 19.19 14.14 9.9
4.4 20.20 15.15 10.10 5.5

GPS Vector File Format

GPS Vector files have the following format:

Header//Topcon Vector Format:v.number of the version,linear units,)
VPP(for vector),Name_Point1,Name_Point2,dX,dY,dZ,sigma_dX,sigma_dY,sigma_dZ,cor_XY,cor_XZ,cor_YZ,
P(for point),Name_Point,Lat(DD MMSS.ss),Lon(DD MMSS.ss),Ell.Height,Code,Note,
//TopconVectorFormat:v.1,Meters,
VPP,1,2,2.4498,2.7704,-3.2041,0.00131407,0.00106341,0.00257335,0.2479,0.5525,0.2098
VPP,1,3,0.3370,3.5418,-3.8074,0.00154384,0.00201876,0.00239150,0.4817,0.4323,0.4580
VPP,2,3,-2.1339,0.7589,-0.6185,0.00315621,0.00445384,0.00476713,0.4766,0.3580,0.4004
VPP,1,4,2.9617,1.0948,-4.1492,0.00743030,0.00466686,0.00739715,0.2438,0.1733,0.3977
VPP,2,4,0.5134,-1.6737,-0.9458,0.00467626,0.00271100,0.00492552,0.2998,0.1997,0.3185
VPP,3,4,2.6111,-2.4383,-0.3702,0.01177912,0.00991061,0.0118924,0.6141,0.4192,0.4301
P,1,55 33 45.60559,37 58 40.69849,147.849,Hiper XT,Base_St
P,2,55 33 45.44999,37 58 40.73705,147.266,,
P,3,55 33 45.47084,37 58 40.84595,146.087,Left_C
P,4,55 33 45.44942,37 58 40.64386,146.128,Legant E,Right_C

Note

Code

Note
## Cut Sheet Files

### Cut Sheet Standard File:

**Stakeout Cut/Fill Data Sheet**

<table>
<thead>
<tr>
<th>TIME</th>
<th>DATE</th>
</tr>
</thead>
</table>

**JOB NAME**: stake_example.tlsv  
**UNITS**: Meters

**PT#CBL_1000 CODE:GCP**

<table>
<thead>
<tr>
<th>NORTH</th>
<th>EAST</th>
<th>ELEVATION</th>
<th>CUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>123088.194</td>
<td>120003.252</td>
<td>-20.068</td>
<td></td>
</tr>
</tbody>
</table>

**STAKEOUT**:  
Sta#CBL_1000_stk 123088.199 120003.249 -20.079  
Difference -0.005 0.003 0.011 0.01

**PT#CBL_150 CODE:GCP**

<table>
<thead>
<tr>
<th>NORTH</th>
<th>EAST</th>
<th>ELEVATION</th>
<th>CUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>123383.566</td>
<td>120800.212</td>
<td>-17.929</td>
<td></td>
</tr>
</tbody>
</table>

**STAKEOUT**:  
Sta#CBL_150_stk 123383.571 120800.215 -17.922  
Difference -0.005 -0.003 -0.007 -0.01

**PT#W_1001 CODE:RBCS**

<table>
<thead>
<tr>
<th>NORTH</th>
<th>EAST</th>
<th>ELEVATION</th>
<th>CUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>123367.665</td>
<td>120542.960</td>
<td>-19.751</td>
<td></td>
</tr>
</tbody>
</table>

**STAKEOUT**:  
Sta#W_1001_stk 123367.572 120543.034 -19.555  
Difference 0.092 -0.073 -0.197 -0.20

**PT#W_1002 CODE:RBCS**

<table>
<thead>
<tr>
<th>NORTH</th>
<th>EAST</th>
<th>ELEVATION</th>
<th>CUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT#</td>
<td>CODE: RBCS</td>
<td>NORTH</td>
<td>EAST</td>
</tr>
<tr>
<td>--------------</td>
<td>------------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>W_1003</td>
<td></td>
<td>123360.530</td>
<td>120533.682</td>
</tr>
</tbody>
</table>

STAKEOUT:

Sta#W_1003_stk | 123356.197 | 120543.745 | -16.867 |
Difference      | -4.333     | -10.064   | -2.651  | -2.65   |

<table>
<thead>
<tr>
<th>PT#</th>
<th>CODE: RBCS</th>
<th>NORTH</th>
<th>EAST</th>
<th>ELEVATION</th>
<th>CUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>W_1006</td>
<td></td>
<td>123386.661</td>
<td>120600.195</td>
<td>-19.649</td>
<td></td>
</tr>
</tbody>
</table>

STAKEOUT:

Sta#W_1006_stk | 123387.294 | 120599.928 | -19.371 |
Difference      | -0.633     | 0.268     | -0.278  | -0.28    |
Sta#W_1006_stk2| 123387.219 | 120599.931 | -19.391 |
Difference      | -0.557     | 0.264     | -0.258  | -0.26    |
Sta#W_1006_stk3| 123387.016 | 120600.010 | -18.922 |
Difference      | -0.354     | 0.185     | -0.727  | -0.73    |
Sta#W_1006_stk4| 123386.843 | 120600.222 | -18.670 |
Difference      | -0.182     | -0.027    | -0.979  | -0.98    |
Cut Sheet User Defined File:

Cut Sheet User Defined File has the following full format (you can hide/move up/move down any column, unless ‘Design Point’, from this format):

```
Header>> Delimiter() FileFormat(Design Point,Code,Staked Point,Design North,Design East,Design Elevation,Station North,Station East,Station Elevation,Delta North,Delta East,Delta Elevation,Cut,Fill,Cut(Fill),Time Stamp,Offset Direction,Offset Distance) <<
```

**Example Entries:**

```
CBL_1000GCPCBL_1000_stk123088.194123088.199
120003.249-20.0790.005-0.010.000.0110.0112004:06:22 14:01:241
330.9410.005

CBL_150GCPCBL_150_stk123383.566123383.571
120800.215-17.9220.000.0070.0070.000-0.0072004:06:22 16:07:581
32.6870.006

W_1001RBCSW_1001_stk12367.66512367.676
141.5480.118

W_1002RBCSW_1002_stk123355.342123355.348
120544.773-19.350-0.010.0250.000-0.0252004:06:22 15:04:211
181.0590.557

W_1002RBCSW_1002_stk2123355.342123355.348
120545.016-20.2410.0560.233-0.8660.000-0.8662004:06:22 15:05:202
76.5010.239

W_1002RBCSW_1002_stk3123355.342123355.348
120544.771-19.350-0.010.0250.000-0.0252004:06:22 15:04:211
181.0590.557

W_1002RBCSW_1002_stk4123355.342123355.348
120544.771-19.350-0.010.0250.000-0.0252004:06:22 15:04:211
181.0590.557

W_1002RBCSW_1002_stk5123355.342123355.348
120544.771-19.350-0.010.0250.000-0.0252004:06:22 15:04:211
181.0590.557
```

---

**C-18**

Topcon Link Reference Manual
Printed File Formats

Topcon Link can print data from the **Point** tab, the **GPS Occupation** tab, the **TS obs** tab, the **GPS Obs** tab and **Tape Obs** tab.

- **Point** tab selected (Figure C-1).

![Sample Printed Point tab](image1.png)

- **TS Obs** tab, left panel selected (Figure C-2).

![Sample Printed – TS Obs Tab, Left Panel](image2.png)
Sample File Formats

- **TS Obs** tab, right panel selected (Figure C-3).

```
<table>
<thead>
<tr>
<th>Icon</th>
<th>Point Name</th>
<th>Point To</th>
<th>Reflexor Height (Unit: M)</th>
<th>Horizontal Circle</th>
<th>Slope Distance/Raw Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ST2</td>
<td>TSN</td>
<td>5.249</td>
<td>15.0</td>
<td>576° 49' 54.929</td>
</tr>
<tr>
<td>2</td>
<td>ST2</td>
<td>M4H</td>
<td>5.249</td>
<td>15.0</td>
<td>576° 49' 54.929</td>
</tr>
<tr>
<td>3</td>
<td>ST2</td>
<td>GT1</td>
<td>5.249</td>
<td>15.0</td>
<td>576° 49' 54.929</td>
</tr>
<tr>
<td>4</td>
<td>ST2</td>
<td>ST1</td>
<td>5.249</td>
<td>15.0</td>
<td>576° 49' 54.929</td>
</tr>
<tr>
<td>5</td>
<td>ST2</td>
<td>9</td>
<td>5.249</td>
<td>15.0</td>
<td>576° 49' 54.929</td>
</tr>
<tr>
<td>6</td>
<td>ST2</td>
<td>L0</td>
<td>5.249</td>
<td>15.0</td>
<td>576° 49' 54.929</td>
</tr>
<tr>
<td>7</td>
<td>ST2</td>
<td>L1</td>
<td>5.249</td>
<td>15.0</td>
<td>576° 49' 54.929</td>
</tr>
<tr>
<td>8</td>
<td>ST2</td>
<td>L2</td>
<td>5.249</td>
<td>15.0</td>
<td>576° 49' 54.929</td>
</tr>
<tr>
<td>9</td>
<td>ST2</td>
<td>L3</td>
<td>5.249</td>
<td>15.0</td>
<td>576° 49' 54.929</td>
</tr>
<tr>
<td>10</td>
<td>ST2</td>
<td>L4</td>
<td>5.249</td>
<td>15.0</td>
<td>576° 49' 54.929</td>
</tr>
</tbody>
</table>
```

**Figure C-3. Sample Printed – TS Obs Tab, Right Panel**

- **GPS Occupations** tab selected (Figure C-4).

```
<table>
<thead>
<tr>
<th>Icon</th>
<th>Point Name</th>
<th>Original Name</th>
<th>Antenna Type</th>
<th>Antenna Height (Unit: M)</th>
<th>Method</th>
<th>Start Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ST2</td>
<td>ST2</td>
<td>100</td>
<td>1.400</td>
<td>Vertical</td>
<td>6/24/2004 06:46:06</td>
</tr>
<tr>
<td>2</td>
<td>ST2</td>
<td>ST2</td>
<td>100</td>
<td>1.400</td>
<td>Vertical</td>
<td>6/24/2004 06:46:06</td>
</tr>
<tr>
<td>3</td>
<td>ST2</td>
<td>ST2</td>
<td>100</td>
<td>1.400</td>
<td>Vertical</td>
<td>6/24/2004 06:46:06</td>
</tr>
<tr>
<td>4</td>
<td>ST2</td>
<td>ST2</td>
<td>100</td>
<td>1.400</td>
<td>Vertical</td>
<td>6/24/2004 06:46:06</td>
</tr>
<tr>
<td>5</td>
<td>ST2</td>
<td>ST2</td>
<td>100</td>
<td>1.400</td>
<td>Vertical</td>
<td>6/24/2004 06:46:06</td>
</tr>
<tr>
<td>6</td>
<td>ST2</td>
<td>ST2</td>
<td>100</td>
<td>1.400</td>
<td>Vertical</td>
<td>6/24/2004 06:46:06</td>
</tr>
<tr>
<td>7</td>
<td>ST2</td>
<td>ST2</td>
<td>100</td>
<td>1.400</td>
<td>Vertical</td>
<td>6/24/2004 06:46:06</td>
</tr>
<tr>
<td>8</td>
<td>ST2</td>
<td>ST2</td>
<td>100</td>
<td>1.400</td>
<td>Vertical</td>
<td>6/24/2004 06:46:06</td>
</tr>
<tr>
<td>9</td>
<td>ST2</td>
<td>ST2</td>
<td>100</td>
<td>1.400</td>
<td>Vertical</td>
<td>6/24/2004 06:46:06</td>
</tr>
<tr>
<td>10</td>
<td>ST2</td>
<td>ST2</td>
<td>100</td>
<td>1.400</td>
<td>Vertical</td>
<td>6/24/2004 06:46:06</td>
</tr>
</tbody>
</table>
```

**Figure C-4. Sample Printed TopSURV File – GPS Occupations Tab**

- **Codes** tab, selected left panel (Figure C-5).

```
<table>
<thead>
<tr>
<th>IconCode</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ST2</td>
<td>ST2</td>
<td>ST2</td>
<td>ST2</td>
<td>ST2</td>
<td>ST2</td>
<td>ST2</td>
</tr>
</tbody>
</table>
```

**Figure C-5. Sample Printed – Codes Tab Left Panel**
• **Codes** tab, selected right panel (Figure C-6).

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Default Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>D</td>
<td>18.05</td>
<td>Real Number</td>
</tr>
<tr>
<td>C</td>
<td>C</td>
<td>J1</td>
<td>Integer</td>
</tr>
<tr>
<td>B</td>
<td>B</td>
<td>14289C</td>
<td>Text</td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>88</td>
<td>Menu</td>
</tr>
</tbody>
</table>

Figure C-6. Sample Printed – Codes Tab Right Panel

• **Tape** tab selected (Figure C-7)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>WGS84 Latitude</th>
<th>WGS84 Longitude</th>
<th>WGS84 Ell. Height</th>
<th>Code</th>
<th>Control</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>59.41750, 0.27786</td>
<td>37.93756, -96.975</td>
<td>212.170</td>
<td>None</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td></td>
<td>100</td>
<td>59.41750, 1.97105</td>
<td>37.93756, -95.000</td>
<td>212.170</td>
<td>None</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td></td>
<td>101</td>
<td>59.41750, 0.50000</td>
<td>37.93756, -95.000</td>
<td>212.170</td>
<td>None</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td></td>
<td>102</td>
<td>59.41750, 0.50000</td>
<td>37.93754, -76.000</td>
<td>212.170</td>
<td>None</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td></td>
<td>103</td>
<td>59.41750, 0.50000</td>
<td>37.93754, -91.000</td>
<td>212.170</td>
<td>None</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td></td>
<td>104</td>
<td>59.41750, 0.50000</td>
<td>37.93757, -97.000</td>
<td>212.170</td>
<td>None</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td></td>
<td>105</td>
<td>59.41750, 0.50000</td>
<td>37.93757, -96.000</td>
<td>212.170</td>
<td>None</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td></td>
<td>106</td>
<td>59.41750, 0.50000</td>
<td>37.93756, -96.000</td>
<td>212.170</td>
<td>None</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>59.41750, 0.50000</td>
<td>37.93758, -92.000</td>
<td>212.170</td>
<td>None</td>
<td>False</td>
<td>False</td>
</tr>
</tbody>
</table>

Figure C-7. Sample Printed – Tape Tab
Cables/COM Ports

Serial Interface Cable

Serial interface cables connect the total station (TS) with an IBM PC compatible computer.

- F-4 cable (GTS – D-sub 9 pins). Table D-1 describes pin connections for the TS and computer (PC).

<table>
<thead>
<tr>
<th>(GTS)</th>
<th>(PC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GND</td>
<td>(1)</td>
</tr>
<tr>
<td>N.C.</td>
<td>(2)</td>
</tr>
<tr>
<td>TXD</td>
<td>(3)</td>
</tr>
<tr>
<td>RXD</td>
<td>(4)</td>
</tr>
<tr>
<td>(RTS)</td>
<td>(5)</td>
</tr>
<tr>
<td>N.C.</td>
<td>(6)</td>
</tr>
</tbody>
</table>

- F-3 cable (GTS – D-sub 25 pins). Table D-2 describes pin connections for the TS and computer (PC).

<table>
<thead>
<tr>
<th>(GTS)</th>
<th>(PC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GND</td>
<td>(1)</td>
</tr>
<tr>
<td>N.C.</td>
<td>(2)</td>
</tr>
<tr>
<td>TXD</td>
<td>(3)</td>
</tr>
<tr>
<td>RXD</td>
<td>(4)</td>
</tr>
</tbody>
</table>

Table D-1. F-4 Cable

Table D-2. F-3 Cable
Parallel Interface Cable

The parallel interface cable connects a TS with a Centronics printer. B-2 Cable (GTS Parallel – centronics 1/F 38 pins). Table D-3 describes pin connections for the total station and printer.

Table D-3. F-4 Cable

<table>
<thead>
<tr>
<th>(GTS)</th>
<th>(Printer)</th>
</tr>
</thead>
<tbody>
<tr>
<td>STROB</td>
<td>(1) (1) STROB</td>
</tr>
<tr>
<td>BUSY</td>
<td>(2) (11) INPUT-BUSY</td>
</tr>
<tr>
<td>D0</td>
<td>(3) (2) DATA1</td>
</tr>
<tr>
<td>D1</td>
<td>(4) (3) DATA2</td>
</tr>
<tr>
<td>D2</td>
<td>(5) (4) DATA3</td>
</tr>
<tr>
<td>D3</td>
<td>(6) (5) DATA4</td>
</tr>
<tr>
<td>D4</td>
<td>(7) (6) DATA5</td>
</tr>
<tr>
<td>D5</td>
<td>(8) (7) DATA6</td>
</tr>
<tr>
<td>D6</td>
<td>(9) (8) DATA7</td>
</tr>
<tr>
<td>D7</td>
<td>(10) (9) DATA8</td>
</tr>
<tr>
<td>GND</td>
<td>(11) (14) GND</td>
</tr>
<tr>
<td>N.C.</td>
<td>(12) (16) GND</td>
</tr>
</tbody>
</table>
Serial C-RS232C Connector Definition

The RS232 cable connects the GNSS TPS receiver (ports A and D) with a computer. Figure D-1 shows the pin locations for the receiver’s connector.

Table D-4 gives RS232 connector pin details.

<table>
<thead>
<tr>
<th>Number</th>
<th>Signal Name</th>
<th>Dir</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power_OUT</td>
<td>P</td>
<td>Power Output (I&lt;0.2 A)</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>-</td>
<td>Signal ground</td>
</tr>
<tr>
<td>3</td>
<td>CTS</td>
<td>I</td>
<td>Clear to send</td>
</tr>
<tr>
<td>4</td>
<td>RTS</td>
<td>O</td>
<td>Request to send</td>
</tr>
<tr>
<td>5</td>
<td>RXD</td>
<td>I</td>
<td>Receive data</td>
</tr>
<tr>
<td>6</td>
<td>TXD</td>
<td>O</td>
<td>Transmit data</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td>Not used</td>
</tr>
</tbody>
</table>

The RS232 connector types are sealed receptacle, 7 pin W.W. FISCHER, INC, p/n DBEU 102 A056.
Table D-5 gives connection details for the receiver and cable.

**Table D-5. RS232 Connection Pin Details**

<table>
<thead>
<tr>
<th>TPS Receiver</th>
<th>DB9 Female</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>8</td>
</tr>
<tr>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>6</td>
<td>2</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
</tr>
</tbody>
</table>

**Total Station COM Port Settings**

The following RS-232-C interface options can be set in the **GTS-600** series application program.

- **Baud Rate:** 1200 / 2400 / 4800 / 9600 / 19200 baud
- **Parity:** NONE / ODD / EVEN
- **Data Bits:** 7 / 8
- **Stop Bits:** 1 / 2
- **Protocol:** ACK – NACK (Uploading in FC-5 format only)
  - ONE WAY

The following RS-232-C interface options can be set in the **GTS-700** series application program.

- **Baud Rate:** 300 / 1200 / 2400 / 4800 / 9600 / 19200
- **Parity:** NONE / ODD / EVEN
- **Data Bits:** 7 / 8
- **Stop Bits:** 0 / 1 / 2
- **Protocol:** XON-XOFF
  - ACK – NACK (Uploading in FC-5 format only)
The following RS-232-C interface options can be set in the **GTS-800A** series application program.

- **Baud Rate:** 1200 / 2400 / 4800 / 9600 baud
- **Parity:** NONE / ODD / EVEN
- **Data Bits:** 7 / 8
- **Stop Bits:** 1 / 2
- **Data Format:** ASCII
- **Signal Control:** RTS. Hi / Low

The following RS-232-C interface options can be set in the **GTS-2000** series application program.

- **Baud Rate:** 300 / 600 / 1200 / 2400 / 4800 / 9600 baud
- **Parity:** NONE / ODD / EVEN
- **Data Bits:** 7 / 8
- **Stop Bits:** 1 / 2
- **Protocol:** ACK – NACK (Uploading in FC-5 format only) ONE WAY

The following RS-232-C interface options can be set in the **AP-L1A** series application program.

- **Bit Format:**
  - D8 S1 NONE: 8bit, stop 1, NONE
  - D8 S2 NONE: 8bit, stop 2, NONE
  - D7 S1 NONE: 7bit, stop 1, NONE
  - D7 S2 NONE: 7bit, stop 2, NONE
  - D8 S1 EVEN: 8bit, stop 1, EVEN
  - D8 S2 EVEN: 8bit, stop 2, EVEN
  - D7 S1 EVEN: 7bit, stop 1, EVEN
### Cables/COM Ports

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>D7 S2 EVEN</td>
<td>7bit, stop 2, EVEN</td>
<td></td>
</tr>
<tr>
<td>D8 S1 ODD</td>
<td>8bit, stop 1, ODD</td>
<td></td>
</tr>
<tr>
<td>D8 S2 ODD</td>
<td>8bit, stop 2, ODD</td>
<td></td>
</tr>
<tr>
<td>D7 S1 ODD</td>
<td>7bit, stop 1, ODD</td>
<td></td>
</tr>
<tr>
<td>D7 S2 ODD</td>
<td>7bit, stop 2, ODD</td>
<td></td>
</tr>
</tbody>
</table>

Trans speed in baud:  
<table>
<thead>
<tr>
<th>COM1</th>
<th>COM2</th>
</tr>
</thead>
<tbody>
<tr>
<td>38400</td>
<td>\n</td>
</tr>
<tr>
<td>4800</td>
<td>4800</td>
</tr>
<tr>
<td>2400</td>
<td>2400</td>
</tr>
<tr>
<td>1200</td>
<td>1200</td>
</tr>
</tbody>
</table>

Terminate:  
| EXT, ETX+CR, ETX+CRLF |

Protocol:  
| (only for COM2) |

Selecting items  
| SERIAL | Based on RS-232C (3 lines system) |
| MODEM  | Based on RS-232C. |
GNSS Receiver COM Port Settings

The following RS-232-C interface options are default communication settings for the GNSS receiver application program.

- Port input mode: CMD for GRIL or Command for PC-CDU; the port is in command mode. In this mode the port recognizes the commands sent by the user.
- Hardware handshaking: OFF
- Serial port baud rate: 115200 baud
- Stop bits: 1
- Parity: N (no parity)
- Data bits: 8
Notes:
Index

A
ActiveSync 2-6–2-9
  settings
    one COM port 2-8
    two COM ports 2-9
  starting 2-6
Adjustment 5-10–5-15
  See also Methods of adjustment
    network 5-10
    traverse 5-10
    type 5-11
Angle balance method 5-15
Antenna properties 4-61
Arrange window 1-9
Azimuth balance method 5-15

B
Background map 4-38

C
Cable
  See also Serial cables
    parallel interface D-2
CAD view 4-37
  options 4-38
Codes
  See also Edit, codes
    add 4-59
    edit 4-67–4-68
    tab 4-26
Codes view 5-19
Compass rule 5-13
Compute coordinates 5-5, 5-9
  See also Process
Control point
    accuracy 5-2
    location 5-2
Controller
  import files 2-6
  import from 2-10, 2-11, 2-26
Convert files 3-4
  coordinate files 3-10–3-14
  GNSS raw data file 3-25, 3-26
  GPS+ raw data file 3-25, 3-26
  Topcon XML files 3-23–3-24
  TopSURV files 3-15
  TS raw data files 3-18–3-21
Convert files from 3-1
  coordinate file 3-10
  GPS+ raw data files 3-25, 3-26
  Topcon XML 3-23
  TopSURV files 3-15
  TS raw data files 3-18
Convert files to 3-2
  FC-5 points 3-14
    feature format 3-32, 3-34
  Geoid format 3-31
  GIS format 3-26, 3-27–3-29
  GNSS raw data file 3-29, 3-30
  GPS vector file 3-33
  GPS+ raw data file 3-29, 3-30
  GTS points 3-14
  RINEX 3-30
  Topcon geoid format 3-31
  TPD file 3-29
Coordinate computation 5-5, 5-9
Coordinate files 1-1
Coordinates, edit 4-58
Crandal method 5-14
Custom format
  properties 3-22, 3-33
Index

Custom formats 3-38, 4-2

D
Digital levels 4-18
DL Obs 4-18
  table information 4-18
DTM
  show lines 4-38

E
Edit
  antenna 4-61
  CAD 4-46
  code 4-55
  codes 4-46, 4-59, 4-67
  coordinate
    files 4-43-4-46
    points 4-45, 5-8
  coordinates 4-58
  instrument 4-50, 4-56
  job configuration 4-55
  menu 1-7
  multiple points 4-56
  note 4-44
  offsets 4-46, 4-52, 4-60, 4-64
  point name 4-44, 4-50, 4-58,
    4-61
  point to 4-51
  string properties 4-53
  TopSURV files 4-56-4-68
  TS Obs 4-65
  TS raw data files 4-49-4-56
Export files 2-32
  OAF 2-32
  to device 2-25
Exporting to a Total Station 2-28
Exporting to a TPS Controller 2-26

F
Feature file format 3-32, 3-34
File 1-7
  formats 4-1
  menu 1-7
  open 4-1-4-2
  open user-defined 4-2-4-4
  properties 4-39-4-40
  save as 4-41, 4-42, 4-48
  symbols 4-9, 4-14, 4-20, 4-35
Formats 4-1
  coordinate C-1-C-4
  custom 3-38, 4-2
  DXF C-11
  GIS 3-26, 3-27
  GTS-6 C-1, C-5
  GTS-7 C-2, C-6
  GTS-7+ C-9
  name,E,N,Z,code C-3
  name,Lat,Long,Ht,code C-3
  printed files C-19
  raw data C-5-C-9
  user-defined 4-2
  XML C-9

G
Geoid
  localization 5-3
  Geoid format, convert to 3-31
Geoid model
  add 3-10-3-11, 3-17, 3-28,
    3-36-3-37
  select 3-11, 3-17, 3-29, 3-37
GIS file formats 3-26, 3-27
GNSS receiver COM port status D-7
GPS Obs
  tab 4-24, 4-28
GPS occupations
  tab information 4-22
GPS vector file 3-33
Grid to ground parameters 3-14
GTS-6
  coordinate format C-1
  raw format C-5
GTS-7
  coordinate format C-2
  raw format C-6
H
Help menu 1-9

I
Images
  panel information 4-29
Import
  from CE-based TS 2-10, 2-11, 2-26
  from controller 2-10, 2-11, 2-26
  from receiver 2-23
Import files
  from CE-based Total Station 2-6
  from device 2-1
  from TPS controller 2-6
Install
  ActiveSync 2-6
  Topcon Link 1-3-1-5

J
Job configuration 5-15

L
Least-squares method 5-13
Linework 4-26
  table information 4-26
Localization 5-1
  and geoid 5-3

M
Map view
  labels 4-38
Menu bar 1-6, 1-7–1-9
Methods of adjustment 5-13–5-15

N
Name,E,N,Z,Code coordinate format
  C-3
Name,Lat,Lon,ht,Code coordinate
  format C-3
Name,N,E,Z,Code coordinate format
  C-4
Network adjustment 5-10

O
OAF A-1
OAFs A-1
Offsets 4-23
Orients, edit 4-46, 4-52, 4-60, 4-64
Open job 1-10
Orthometric height 3-10, 3-27, 3-28

P
Parameters
  ASCII/TSV files 3-12
  custom text files 3-12
  GLONASS 3-30
  grid to ground 3-14
  job configuration 5-15
  L1/L2 3-30
  name, lat, lon, ht 3-13
  other coordinate files 3-13
  RINEX 3-30
  user-defined 5-15
Point limits 3-32
Points
  process 5-5, 5-9, 5-9, 5-11–5-12
  properties 4-44, 4-45, 4-46, 4-8
Points tab
  coordinate file 4-9
  TopSURV file 4-21
  TS file 4-11
Print
  formats C-19
  setup 5-21
Process 5-5, 5-9–5-12
  menu 1-8
  properties 5-11
Properties
  custom format 3-38, 4-2
  file 4-39–4-40
  process 5-11
Index

R
Receiver
  connect with computer 2-8
  export files to 2-32
  import files 2-23
Refraction coefficient 5-12

S
Save files 1-10, 4-41
  to current file/format 4-41
  to different file 4-41
  to different format 4-47
Serial cables
  C-RS232C D-3
    receiver settings D-7
    TS settings D-4–D-6
    interface D-1
Settings
  ActiveSync 2-8–2-9
  apriori values 5-12
Shortcuts 1-5, 1-6
Sort
  DL tab 4-19
Status bar 1-6, 1-12
  configuration options 1-12
Symbols 4-9, 4-14, 4-20, 4-35
System requirements 1-3

T
Tape dimensions 4-28, 4-30, 4-31
Toolbar 1-6, 1-10–1-12
Topcon geoid format, convert to 3-31
Topcon XML file format C-9
TopSURV files 3-15
Total Station
  COM port status D-4–D-6
  import files CE-based 2-6
Total station
  import from CE-based 2-10, 2-11,
  2-26
Transit rule 5-14
Traverse adjustment 5-10
TS Obs tab 4-12–4-13, 4-23–4-24

U
User-defined format 4-2
Using Windows Explorer 2-26, 2-28

V
View 1-8
  coordinate file 4-8
  file properties 4-39–4-40
  menu 1-8
  point observations 4-25
  tape dimensions 4-28
  TopSURV files 4-21
  TS raw data file 4-11

W
Window menu 1-9

X
X-section 4-34